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DLP-D300 Clear an MS-SPRing Span Lockout
Purpose
Tools/Equipment

This task clears a multiplex section-shared protection ring (MS-SPRing) span
lockout. A lockout switches all traffic away from a span.
None

DLP-D300 Clear an MS-SPRing Span Lockout
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Prerequisite
Procedures

DLP-D60 Log into CTC

DLP-D299 Initiate an MS-SPRing Span Lockout
Required/As Needed As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Caution! Traffic is not protected during a span lockout.
1. From the View menu, choose Go to Network View.
2. Click the Provisioning > MS-SPRing tabs.
3. Choose the MS-SPRing and click Edit.
Tip: To move an icon to a new location, for example, to see MS-SPRing channel (port) information more
clearly, press Ctrl and drag and drop the icon to a new location on the Edit MS-SPRing network graphic.
4. Right-click the MS-SPRing node channel (port) where the lockout will be cleared and choose Set
West Protection Operation or Set East Protection Operation.
5. In the dialog box, choose CLEAR from the drop-down list. Click OK.
6. In the Confirm MS-SPRing Operation dialog box, click Yes.
7. From the File menu, choose Close.
8. Return to your originating procedure (NTP).

DLP-D301 Initiate an MS-SPRing Manual Ring Switch
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As
Needed
Onsite/Remote
Security Level

This task performs an MS-SPRing Manual ring switch. A Manual ring switch will
switch traffic off a span if there is no higher priority switch (Force or lockout) and no
signal degrade (SD) or signal failure (SF) conditions.
None
DLP-D60 Log into CTC
As needed
Onsite or remote
Provisioning or higher

1. From the View menu, choose Go to Network View.
2. Click the Provisioning > MS-SPRing tabs.
3. Choose the MS-SPRing and click Edit.
Tip: To move an icon to a new location, for example, to see MS-SPRing channel (port) information more
clearly, click an icon on the Edit MS-SPRing network graphic and while pressing Ctrl, drag the icon to a
new location.
4. Right-click any MS-SPRing node channel (port) and choose Set West Protection Operation (if you
chose a west channel) or Set East Protection Operation (if you chose an east channel).
Note: The squares on the node icons represent the MS-SPRing working and protect
channels. You can right-click either channel. For four-fiber MS-SPRings, the squares
represent ports. Right-click either working port.
5. In the Set West Protection Operation dialog box or the Set East Protection Operation dialog box,
choose MANUAL RING from the drop-down list. Click OK.
DLP-D301 Initiate an MS-SPRing Manual Ring Switch
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6. Click Yes in the two Confirm MS-SPRing Operation dialog boxes.
7. Verify that the channel (port) displays the letter "M" for Manual ring. Also verify that the span lines
between the nodes where the Manual switch was invoked turn purple, and that the span lines between
all other nodes turn green. This confirms the Manual switch.
8. From the File menu, choose Close.
9. Return to your originating procedure (NTP).

DLP-D303 Initiate an MS-SPRing Force Ring Switch
Purpose

This task performs a Force Ring protection switch on an MS-SPRing. A Force ring
switch will switch traffic off a span if there is no SD, SF, or lockout switch present on
the span.
None

Tools/Equipment
Prerequisite
DLP-D60 Log into CTC
Procedures
Required/As
As needed
Needed
Onsite/Remote
Onsite
Security Level
Provisioning or higher
Caution! Traffic is not protected during a Force Ring protection switch.

1. From the View menu, choose Go to Network View.
2. Click the Provisioning > MS-SPRing tabs.
3. Click Edit.
4. To apply a Force switch to the west line:
1. Right-click the west MS-SPRing port where you want to switch the MS-SPRing traffic and
choose Set West Protection Operation (Figure 20-1).
Note: If node icons overlap, drag and drop the icons to a new location. You can also
return to network view and change the positions of the network node icons, because
MS-SPRing node icons are based on the network view node icon positions.
Note: For two-fiber MS-SPRings, the squares on the node icons represent the
MS-SPRing working and protect channels. You can right-click either channel. For
four-fiber MS-SPRings, the squares represent ports. Right-click either working port.
Figure 20-1: Invoking a Protection Operation on a Three-Node MS-SPRing

2. In the Set West Protection Operation choose FORCE RING from the drop-down list. Click
OK.
3. Click Yes in the two Confirm MS-SPRing Operation dialog boxes that appear.
DLP-D303 Initiate an MS-SPRing Force Ring Switch
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On the network graphic, an F appears on the working MS-SPRing channel where you
invoked the protection switch. The span lines change color to reflect the forced traffic. Green
span lines indicate the new MS-SPRing path, and the lines between the protection switch are
purple.
Performing a Force switch generates several conditions including FORCED-REQ-RING and
WKSWPR.
5. To apply a Force switch to the east line:
1. Right-click the east MS-SPRing port and choose Set East Protection Operation.
Note: If node icons overlap, drag and drop the icons to a new location. You can also
return to network view and change the positions of the network node icons because
MS-SPRing node icons are based on the network view node icon positions.
Note: For two-fiber MS-SPRings, the squares on the node icons represent the
MS-SPRing working and protect channels. You can right-click either channel. For
four-fiber MS-SPRings, the squares represent ports. Right-click either working port.
2. In the Set East Protection Operation dialog box, choose FORCE RING from the drop-down
list. Click OK.
3. Click Yes in the two Confirm MS-SPRing Operation dialog boxes that appear.
On the network graphic, an F appears on the working MS-SPRing channel where you
invoked the protection switch. The span lines change color to reflect the forced traffic. Green
span lines indicate the new MS-SPRing path, and the lines between the protection switch are
purple.
Performing a Force switch generates several conditions including FORCED-REQ-RING and
WKSWPR.
6. From the File menu, choose Close.
7. Return to your originating procedure (NTP).

DLP-D309 View Ethernet MAC Address Table
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

This task displays the Ethernet MAC address table for any node with one or more
E-Series Ethernet cards installed.
None
DLP-D60 Log into CTC
As needed
Onsite or remote
Retrieve or higher

1. In node view, click the Maintenance > Ether Bridge > MAC Table tabs.
2. Select the appropriate E-Series Ethernet card in the Layer 2 Domain field.
3. Click the Retrieve button.
The MAC address table information appears.
4. Return to your originating procedure (NTP).

DLP-D310 View Ethernet Trunk Utilization
Purpose
Tools/Equipment
Prerequisite
Procedures

This task changes the screen view to display the Ethernet Trunk bandwidth usage
on a selected card.
None
DLP-D60 Log into CTC

Figure 20-1: Invoking a Protection Operation on a Three-Node MS-SPRing
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Required/As Needed
Onsite/Remote
Security Level

As needed
Onsite or remote
Retrieve or higher

1. In node view, click the Maintenance > Ether Bridge > Trunk Utilization tabs.
2. Select the desired time interval in the Interval field.
3. Click Refresh.
The trunk utilization information for the current and previous time intervals appears.
4. Return to your originating procedure (NTP).

DLP-D311 Provision a Half Circuit Source and Destination on an MS-SPRing or 1+1
Node
This task provisions a half circuit source and destination on an MS-SPRing or
1+1 node. A half circuit allows you to provision a partial path (one end of a
circuit), for example, if you want to provision a circuit with the intent that the
path will be completed at a later time or at a different location.
None
DLP-D60 Log into CTC

Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

This task can only be performed as a part of the NTP-D139 Create a Half Circuit
on an MS-SPRing or 1+1 Node.
As needed
Onsite or remote
Provisioning or higher

1. From the Node drop-down list, choose the node that will contain the half circuit.
2. From the Slot drop-down list, choose the slot containing the card where the circuit will originate.
3. From the Port drop-down list, choose the port where the circuit will originate. This field might not be
available, depending on the card chosen in Step 2.
4. Complete one of the following:
♦ For low-order VC12 circuits, choose the VC4, TUG3, TUG2, and VC12.
♦ For low-order VC11 circuits, choose the VC4, TUG3, TUG2, and VC11.
♦ For low-order VC3 circuits, choose the VC4 and VC3.
♦ For high-order circuits, choose the VC4.
5. Click Next.
6. From the Node drop-down list, choose the node chosen in Step 1.
7. From the Slot drop-down list, choose the STM-N card to map the low-order VC3, VC11, or VC12
circuit for optical transport or to map the VC4 circuit to a synchronous transport module (STM).
8. Choose the destination from the drop-down lists that appear.
9. Return to your originating procedure (NTP).

DLP-D312 Provision a Half Circuit Source and Destination on an SNCP Ring

Purpose
Tools/Equipment

This task provisions a half circuit source and destination on a subnetwork connection
protection (SNCP) ring. A half circuit allows you to provision a partial path (one end of
a circuit), for example, if you want to provision a circuit with the intent that the path
will be completed at a later time or at a different location.
None
DLP-D60 Log into CTC

DLP-D310 View Ethernet Trunk Utilization
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Prerequisite
Procedures
Required/As
Needed
Onsite/Remote
Security Level

This task can only be performed as a part of the NTP-D140 Create a Half Circuit on an
SNCP Ring Node.
As needed
Onsite or remote
Provisioning or higher

1. From the Node drop-down list, choose the node that will contain the half circuit.
2. From the Slot drop-down list, choose the slot containing the card where the circuit will originate.
3. From the Port drop-down list, choose the port where the circuit will originate. This field might not be
available, depending on the card chosen in Step 2.
4. Complete one of the following:
♦ For low-order VC12 circuits, choose the VC4, TUG3, TUG2, and VC12.
♦ For low-order VC11 circuits, choose the VC4, TUG3, TUG2, and VC11.
♦ For low-order VC3 circuits, choose the VC4 and VC3.
♦ For high-order circuits, choose the VC4.
5. Click Next.
6. From the Node drop-down list, choose the node chosen in Step 1.
7. From the Slot drop-down list, choose the STM-N card to map the low-order VC3, VC11, or VC12
circuit for optical transport or to map the VC4 circuit to an STM.
8. Click Next.
9. Choose the destination VC4, TUG3, TUG2, and VC12 from the drop-down lists that appear.
10. Check Use Secondary Destination and repeat Steps 1 through 9.
11. Return to your originating procedure (NTP).

DLP-D314 Assign a Name to a Port
Purpose
Tools/Equipment

This task assigns a name to a port on any ONS 15454 SDH card.
None
DLP-D60 Log into CTC

Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

NTP-D24 Verify Card Installation
As needed
Onsite or remote
Provisioning or higher

1. In node view, double-click the card that has the port you want to provision.
2. Click the Provisioning tab.
3. Click the Port Name column for the port number you are assigning a name to and enter the desired
port name.
The port name can be up to 32 alphanumeric/special characters and is blank by default.
4. Click Apply.
5. Return to your originating procedure (NTP).

DLP-D315 Log Out a User on a Single Node
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed

This task logs out a user from a single node.
None
DLP-D60 Log into CTC
As needed

DLP-D312 Provision a Half Circuit Source and Destination on an SNCP Ring
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Onsite/Remote
Security Level

Onsite or remote
Superuser only

1. In node view, click the Provisioning > Security > Active Logins tabs.
2. Choose the user that you want to log out and click Logout.
3. In the Logout User dialog box, check Lockout before Logout if you want to lock the user out. This
prevents the user from logging in after logout based on user lockout parameters provisioned in the
Policy tab. Either a manual unlock by a Superuser only is required, or the user is locked out for the
amount of time specified in the Lockout Duration field. See the "DLP-D271 Change Node Security
Policy on a Single Node" task for more information.
4. Click OK.
5. Click Yes to confirm the logout.
6. Return to your originating procedure (NTP).

DLP-D316 Log Out a User on Multiple Nodes
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

This task logs out a user from multiple nodes.
None
DLP-D60 Log into CTC
As needed
Onsite or remote
Superuser only

1. From the View menu, chose Go to Network View.
2. Click the Provisioning > Security > Active Logins tabs.
3. Choose the user you want to log out.
4. Click Logout.
5. In the Logout User dialog box, check the nodes where you want to log out the user.
6. In the Logout User dialog box, check Lockout before Logout if you want to lock the user out prior
to logout. This prevents the user from logging in after logout based on user lockout parameters
provisioned in the Policy tab. Either a manual unlock by a Superuser only is required, or the user is
locked out for the amount of time specified in the Lockout Duration field. See the "DLP-D272
Change Node Security Policy on Multiple Nodes" task for more information.
7. In the Select Applicable Nodes area, deselect any nodes where you do not want to change the user's
settings (all network nodes are selected by default).
8. Click OK.
9. In the User Change dialog box, click OK.
10. Return to your originating procedure (NTP).

DLP-D318 Provision a Low-Order VC3 Circuit Source and Destination
Purpose
This task provisions a circuit source and destination for a low-order VC3 circuit.
Tools/Equipment
None
Prerequisite Procedures DLP-D60 Log into CTC
NTP-D54 Create an Automatically Routed Low-Order VC3 Circuit, or
NTP-D55 Create a Manually Routed Low-Order VC3 Circuit, or
NTP-D56 Create a Unidirectional Low-Order VC3 Circuit with Multiple Drops
DLP-D315 Log Out a User on a Single Node
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You must have the Source page of the Circuit Creation wizard open.
Required/As Needed
As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: After you have selected the circuit properties in the Circuit Source dialog box according to the specific
circuit creation procedure, you are ready to provision the circuit source.
1. From the Node drop-down list, choose the node where the source will originate.
2. From the Slot drop-down list, choose the slot containing the E3-12 or DS3i-N-12 card where the
circuit will originate. You can also choose an STM-N card to map the VC3 to a VC4 for optical
transport. Figure 20-2 shows an example of a circuit source for an E3-12 card.
Figure 20-2: Defining the Circuit Source on an E3-12 Card

3. Choose the port from the Port drop-down list.
4. Choose the VC4 from the VC4 drop-down list.
5. Choose the VC3 from the VC3 drop-down list.
6. If you need to create a secondary source, for example, an SNCP ring bridge/selector circuit entry
point in a multivendor SNCP ring, click Use Secondary Source and repeat Steps 1 through 5 to
define the secondary source. If you do not need to create a secondary source, continue with Step 7.
7. Click Next.
8. From the Node drop-down list, choose the destination (termination) node.
9. From the Slot drop-down list, choose the slot containing the destination card. The destination is
typically a E3 or DS3 card. However, you can also choose an STM-N card to map the VC3 to a VC4
for optical transport.
10. Depending on the destination card, choose the destination port from the drop-down lists that appear
based on the card selected in Step 2. See Table 6-2 for a list of valid options. Cisco Transport
Controller (CTC) does not show ports, VC4s, or VC3s already used by other circuits.
Note: If you and a user working on the same network choose the same port, VC4, or VC3
simultaneously, one of you receives a Path in Use error and is unable to complete the circuit.
The user with the PARTIAL circuit needs to choose new destination parameters.
11. If you need to create a secondary destination, for example, an SNCP ring bridge/selector circuit exit
point in a multivendor SNCP ring, click Use Secondary Destination and repeat Steps 8 through 10
to define the secondary destination.
12. Click Next.
13. Return to your originating procedure (NTP).
DLP-D318 Provision a Low-Order VC3 Circuit Source and Destination
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DLP-D319 Set Up a Solaris Workstation for a Craft Connection to an ONS 15454
SDH
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

This task sets up a Solaris workstation for a craft connection to the ONS
15454 SDH.
None
NTP-D278 Set Up Computer for CTC
As needed
Onsite
None

1. Log into the workstation as the root user.
2. Check to see if the interface is plumbed by typing:
# ifconfig device
For example:
# ifconfig hme1
If the interface is plumbed, a message similar to the following appears:
hme1:flags=1000842BROADCAST,RUNNING,MULTICAST,IPv4>mtu 1500
index 2 inet 0.0.0.0 netmask 0
If a message similar to this one appears, go to Step 4.
If the interface is not plumbed, a message similar to the following appears:
ifconfig: status: SIOCGLIFFLAGS: hme1: no such interface.
If a message similar to this one appears, go to Step 3.
3. Plumb the interface by typing:
# ifconfig device plumb
For example:
# ifconfig hme1 plumb
4. Configure the IP address on the interface by typing:
# ifconfig interface ip-address netmask netmask up
For example:
# ifconfig hme0 192.1.0.3 netmask 255.255.255.0 up
Note: Enter an IP address that is identical to the ONS 15454 SDH IP address except for the
last octet. The last octet must be 1 or 3 through 254.
5. In the Subnet Mask field, type 255.255.255.0. Skip this step if you checked Enable Socks Proxy on
Port and External Network Element (ENE) at Provisioning > Network > General > Gateway
Settings.
6. Test the connection:
1. Start Netscape Navigator.
2. Enter the Cisco ONS 15454 SDH IP address in the web address (URL) field. If the
connection is established, a Java Console window, CTC caching messages, and the Cisco
Transport Controller Login dialog box appear. If this occurs, go to Step 2 of the "DLP-D60
Log into CTC" task to complete the login. If the Login dialog box does not appear, complete
SubSteps 3 and 4.
3. At the prompt, type:
DLP-D319 Set Up a Solaris Workstation for a Craft Connection to an ONS 15454 SDH
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ping ONS-15454-SDH-IP-address
For example, to connect to an ONS 15454 SDH with a default IP address of
192.1.0.2, type:
ping 192.1.0.2
If your workstation is connected to the ONS 15454 SDH, the following message
appears:
IP-address is alive
Note: Skip this step if you checked Enable Socks Proxy on Port and External
Network Element (ENE) at Provisioning > Network > General > Gateway Settings.
4. If CTC is not responding, a "Request timed out" (Windows) or a "no answer from x.x.x.x"
(UNIX) message appears. Verify the IP and subnet mask information. Check that the cables
connecting the workstation to the ONS 15454 SDH are securely attached. Check the link
status by typing:
# ndd -set /dev/device instance 0
# ndd -get /dev/device link_status
For example:
# ndd -set /dev/hme instance 0
# ndd -get /dev/hme link_status
A result of 1 means that the link is up. A result of 0 means that the link is down.
Note: Check the man page for ndd. For example, type man ndd at the prompt.
7. Return to your originating procedure (NTP).

DLP-D321 Open the FMEC Cover
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

This task opens the Front Mount Electrical Connection (FMEC)
cover.
Medium slot-head screwdriver
DLP-D8 Open the Front Cabinet Compartment (Door)
Required
Onsite
None

1. Unscrew the screws on the FMEC cover (Figure 20-3).
Figure 20-3: Unscrewing the FMEC Cover

DLP-D321 Open the FMEC Cover
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2. Use the handles to pull the cover forward.
3. Return to your originating procedure (NTP).

DLP-D322 Remove the FMEC Cover
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

This task removes the FMEC cover.
Medium slot-head screwdriver
DLP-D321 Open the FMEC Cover
As needed
Onsite
None

1. Unscrew the nut holding the ground wire to the shelf. Remove the nut and washer.
2. Remove the ground wire from the left side of the shelf.
3. Pull the right side of the hinge-locking spring (Figure 20-4).
Figure 20-4: Removing the ONS 15454 SDH FMEC Cover

Figure 20-3: Unscrewing the FMEC Cover
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4. Detach the cover from the pin of the hinge.
5. Remove the cover carefully from the left pin of the hinge.
6. Return to your originating procedure (NTP).

DLP-D324 Install Alarm Cables on the MIC-A/P
Purpose

This task installs alarm cables on the MIC-A/P FMEC so that you can provision
external (environmental) alarms and controls with the AIC-I card.
DB-62 connector

Tools/Equipment
mm² or 0.64 mm² (#22 or #24 AWG) wires
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

NTP-D220 Install the Power and Signal FMECs
As needed
Onsite
None

1. Using 0.51 mm² or 0.64 mm² (#22 or #24 AWG) wires, connect the alarm and control wires on the
appropriate pins of the DB-62 connector. The pin connectors, signal names, and functions are listed
in Table 20-1.
Table 20-1: Alarm Pin Assignments

DB-62 Pin Connector
1
2
3
4
5

Signal Name
ALMCUTOFFALMCUTOFF+
ALMINP0ALMINP0+
ALMINP1-

Function
Alarm cutoff
Alarm cutoff
Alarm input pair number 1
Alarm input pair number 1
Alarm input pair number 2

Figure 20-4: Removing the ONS 15454 SDH FMEC Cover

Wire Color
White/blue
Blue/white
White/orange
Orange/white
White/green
13
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6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49

ALMINP1+
ALMINP2ALMINP2+
ALMINP3ALMINP3+
EXALM0EXALM0+
FGND
EXALM1EXALM1+
EXALM2EXALM2+
EXALM3EXALM3+
EXALM4EXALM4+
EXALM5EXALM5+
EXALM6EXALM6+
FGND
EXALM7EXALM7+
EXALM8EXALM8+
EXALM9EXALM9+
EXALM10EXALM10+
EXALM11EXALM11+
ALMOUP0ALMOUP0+
FGND
ALMOUP1ALMOUP1+
ALMOUP2ALMOUP2+
ALMOUP3ALMOUP3+
AUDALM0AUDALM0+
AUDALM1AUDALM1+

Table 20-1: Alarm Pin Assignments

Alarm input pair number 2
Alarm input pair number 3
Alarm input pair number 3
Alarm input pair number 4
Alarm input pair number 4
Extra alarm 0
Extra alarm 0
Ground
Extra alarm 1
Extra alarm 1
Extra alarm 2
Extra alarm 2
Extra alarm 3
Extra alarm 3
Extra alarm 4
Extra alarm 4
Extra alarm 5
Extra alarm 5
Extra alarm 6
Extra alarm 6
Ground
Extra alarm 7
Extra alarm 7
Extra alarm 8
Extra alarm 8
Extra alarm 9
Extra alarm 9
Extra alarm 10
Extra alarm 10
Extra alarm 11
Extra alarm 11
Normally open output pair number 1
Normally open output pair number 1
Ground
Normally open output pair number 2
Normally open output pair number 2
Normally open output pair number 3
Normally open output pair number 3
Normally open output pair number 4
Normally open output pair number 4
Normally open minor audible alarm
Normally open minor audible alarm
Normally open major audible alarm
Normally open major audible alarm

Green/white
White/brown
Brown/white
White/gray
Gray/white
Red/blue
Blue/red
Red/orange
Orange/red
Red/green
Green/red
Red/brown
Brown/red
Red/gray
Gray/red
Black/blue
Blue/black
Black/orange
Orange/black
Black/green
Green/black
Black/brown
Brown/black
Black/gray
Gray/black
Yellow/blue
Blue/yellow
Yellow/orange
Orange/yellow
White/blue
Blue/white
White/orange
Orange/white
White/green
Green/white
White/brown
Brown/white
White/gray
Gray/white
Red/blue
Blue/red
14
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50
51
52
53
54
55
56
57
58
59
50
61
62

AUDALM2AUDALM2+
FGND
AUDALM3AUDALM3+
VISALM0VISALM0+
VISALM1VISALM1+
VISALM2VISALM2+
VISALM3VISALM3+

Normally open critical audible alarm
Normally open critical audible alarm
Ground
Normally open remote audible alarm
Normally open remote audible alarm
Normally open minor visible alarm
Normally open minor visible alarm
Normally open major visible alarm
Normally open major visible alarm
Normally open minor visible alarm
Normally open minor visible alarm
Normally open minor visible alarm
Normally open minor visible alarm

Red/orange
Orange/red
Red/green
Green/red
Red/brown
Brown/red
Red/gray
Gray/red
Black/blue
Blue/black
Black/orange
Orange/black

2. Connect the other end of the alarm and control wires according to local site practice.
3. Connect the DB-62 connector to the ALARM IN/OUT connector on the MIC-A/P faceplate.
4. Tighten the screws of the connector on the alarm cable.
5. Return to your originating procedure (NTP).

DLP-D325 Install Timing Cables on the MIC-C/T/P
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

This task installs the timing cables on the MIC-C/T/P FMEC.
75-ohm coaxial cable with a 1.0/2.3 miniature coax connector on the MIC-C/T/P
side
NTP-D220 Install the Power and Signal FMECs
As needed
Onsite
None

1. Using coaxial cable with 1.0/2.3 miniature coax connectors, connect the clock cable to the
appropriate connector on the faceplate of the MIC-C/T/P FMEC.
2. Gently push the cable with the 1.0/2.3 miniature coax connector down until the cable connector
slides into the 1.0/2.3 miniature coax connector on the faceplate with a click.
The MIC-C/T/P provides 1.0/2.3 miniature coax connectors that are used for timing input
and output. The top connectors are for "A" (BITS-1) timing, and the bottom connectors are
for "B" (BITS-2) timing. In each case, the left connector is the input and the right connector
is the output. The input connectors for timing provide a 75-ohm termination. System cables
are available that can convert timing clocks from 75 ohms to 100/120 ohms. Table 20-2
shows MIC-C/T/P pin assignments.
Table 20-2: MIC-C/T/P Clock Connector Pin Assignment

Pin
IN 1
OUT 1
IN 2
OUT 2

Function
Input from external device
Output to external device
Input from external device
Output to external device

DLP-D325 Install Timing Cables on the MIC-C/T/P
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A high-impedance option (> 3 kilo-ohms or greater) is possible through a jumper on the
MIC-C/T/P FMEC. You can change the top timing input to high impedance by removing the
jumper on P3 on the MIC-C/T/P FMEC. You can change the bottom timing input to high
impedance by removing the jumper on P2 of the MIC-C/T/P FMEC.
Note: Refer to ITU-T G.813 for rules about provisioning timing references.
3. Connect the other end of the cable to the external source of the timing signal according to Table
20-2.
4. Repeat Step 3 for each cable that is required.
5. Return to your originating procedure (NTP).

DLP-D326 Install LAN Wires on the MIC-C/T/P
Purpose

This task installs the LAN wires on the MIC-C/T/P FMEC.
Standard CAT-5 unshielded twisted-pair (UTP) Ethernet cable (straight-through for
data terminal equipment [DTE] or cross-over for data circuit-terminating equipment
[DCE])
or

Tools/Equipment
RJ-45 connector
Crimping tool for RJ-45 connector
0.51 mm² or 0.64 mm² (#22 or #24 AWG) wire, preferably CAT-5 UTP
Prerequisite
NTP-D220 Install the Power and Signal FMECs
Procedures
Required/As
As needed
Needed
Onsite/Remote
Onsite
Security Level
None
Note: Rather than using the LAN connection port on the MIC-C/T/P, you can use the LAN connection port
on the TCC2/TCC2P card if preferred. Use either the MIC-C/T/P connection or the TCC2/TCC2P card
connection. You cannot use the LAN connection port on the MIC-C/T/P and the LAN connection port on the
TCC2/TCC2P card simultaneously; however, it is possible for you to make a direct connection from a
computer to the LAN connection port on the TCC2/TCC2P card while the LAN connection port on the
MIC-C/T/P is in use as long as the computer connected directly to the TCC2/TCC2P card is not connected to
the same LAN.
1. Using 0.51 mm² or 0.64 mm² (#22 or #24 AWG) wire or CAT-5 UTP Ethernet cable, connect the
wires to the RJ-45 connector according to Table 20-3 and crimp the connector to the cable.
Table 20-3: LAN Pin Assignments

LAN

RJ-45 Pin RJ-45 Pin
1

3

2

6

LAN 1 Connecting to DCE1 (a hub or switch) Cross-over Ethernet 3
cable

1

Table 20-2: MIC-C/T/P Clock Connector Pin Assignment

Function
PNMSRX+
white/green
PNMSRXgreen
PNMSTX
white/orange
16
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LAN 1 Connecting to DTE (a PC/workstation or router)
Straight-through Ethernet cable

4
5

4
5

6

2

7
8

7
8

1

1

2

2

3

3

4
5

4
5

6

6

7
8

7
8

PNMSTXorange
PNMSRX+
white/green
PNMSRXgreen
PNMSTX+
white/orange
PNMSTXorange
-

1. The Cisco ONS 15454 SDH is DCE.

2. Plug the connector into the LAN connection point.
3. Return to your originating procedure (NTP).

DLP-D328 Install 75-Ohm E-3 or STM-1 Coaxial Cables
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As
Needed
Onsite/Remote
Security Level

This task installs the 75-ohm coaxial cables on FMEC-E3/DS3, and FMEC STM1E
1:1 cards. This task also installs the 75-ohm coaxial cables on the E1-75/120
conversion panel.
75-ohm coaxial cables with 1.0/2.3 miniature coax connectors
NTP-D220 Install the Power and Signal FMECs
As needed
Onsite
None

1. Using coaxial cable with 1.0/2.3 miniature coax connector, connect the coaxial cable to the
appropriate connector on the faceplate of the FMEC.
2. Gently push the cable with the 1.0/2.3 miniature coax connector down until the cable connector
slides into the 1.0/2.3 miniature coax connector on the faceplate with a click.
3. Connect the other end of the cable to the external source or sink of the signal.
4. Repeat Step 3 for each cable required.
5. Return to your originating procedure (NTP).

DLP-D330 Install 120-Ohm E-1 Cables with Molex 96-Pin LFH Connectors
Purpose

This task installs the 120-ohm E-1 cables on FMEC E1-120NP, FMEC
E1-120PROA, and FMEC E1-120PROB cards. Also use this task to install the
120-ohm E-1 cables on the E1-75/120 conversion panel.

Table 20-3: LAN Pin Assignments
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Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

Twisted-pair cables with Molex 96-pin LFH connectors
NTP-D220 Install the Power and Signal FMECs
As needed
Onsite
None

1. Using the cables with Molex 96-pin LFH connectors available from Cisco, connect the male
connector to the female connector on the FMEC card that you want to connect to.
Use Table 20-4 to make the connection from the E-1 96-pin connector for Ports 1 to 21 to the external
balanced 120-ohm E-1 interfaces.
Table 20-4: Pinout for E-1 Interfaces on Ports 1 to 21

Pin Signal
Wire Color
No. Name
TX 11
white-blue
1
N
TX 11
blue-white
2
P
TX 10
white-orange
3
N
TX 10
orange-white
4
P
TX 9
white-green
5
N
TX 9
green-white
6
P
TX 8
white-brown
7
N
TX 8
brown-white
8
P
TX 7
9
white-slate
N
TX 7
10
slate-white
P
TX 6
11
red-blue
N
TX 6
12
blue-red
P
TX 5
13
red-orange
N
TX 5
14
orange-red
P
TX 4
15
red-green
N
TX 4
16
green-red
P

Pin Signal
Wire Color
No. Name
RX 11
white-blue
25
N
RX 11
blue-white
26
P
RX 10
white-orange
27
N
RX 10
orange-white
28
P
RX 9
white-green
29
N
RX 9
green-white
30
P
RX 8
white-brown
31
N
RX 8
brown-white
32
P
RX 7
33
white-slate
N
RX 7
34
slate-white
P
RX 6
35
red-blue
N
RX 6
36
blue-red
P
RX 5
37
red-orange
N
RX 5
38
orange-red
P
RX 4
39
red-green
N
RX 4
40
green-red
P

Pin Signal
Wire Color
No. Name
TX 21
black-orange
49
N
TX 21
orange-black
50
P
TX 20
black-green
51
N
TX 20
green-black
52
P
TX 19
black-brown
53
N
TX 19
brown-black
54
P
TX 18
black-slate
55
N
TX 18
slate-black
56
P
TX 17
57
yellow-blue
N
TX 17
58
blue-yellow
P
TX 16
59
yellow-orange
N
TX 16
60
orange-yellow
P
TX 15
61
yellow-green
N
TX 15
62
green-yellow
P
TX 14
63
yellow-brown
N
TX 14
64
brown-yellow
P

Pin Signal
Wire Color
No. Name
RX 21
black-orange
73
N
RX 21
orange-black
74
P
RX 20
black-green
75
N
RX 20
green-black
76
P
RX 19
black-brown
77
N
RX 19
brown-black
78
P
RX 18
black-slate
79
N
RX 18
slate-black
80
P
RX 17
81
yellow-blue
N
RX 17
82
blue-yellow
P
RX 16
83
yellow-orange
N
RX 16
84
orange-yellow
P
RX 15
85
yellow-green
N
RX 15
86
green-yellow
P
RX 14
87
yellow-brown
N
RX 14
88
brown-yellow
P

DLP-D330 Install 120-Ohm E-1 Cables with Molex 96-Pin LFH Connectors
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TX 3
RX 3
TX 13
RX 13
red-brown 41
red-brown 65
yellow-slate 89
yellow-slate
N
N
N
N
TX 3
RX 3
TX 13
RX 13
18
brown-red 42
brown-red 66
slate-yellow 90
slate-yellow
P
P
P
P
TX 2
RX 2
TX 12
RX 12
19
red-slate
43
red-slate
67
violet-blue
91
violet-blue
N
N
N
N
TX 2
RX 2
TX 12
RX 12
20
slate-red
44
slate-red
68
blue-violet
92
blue-violet
P
P
P
P
TX 1
RX 1
21
black-blue 45
black-blue 69 93 N
N
TX 1
RX 1
22
blue-black 46
blue-black 70 94 P
P
23 47 71 95 24 48 72 96 Use Table 20-5 to make the connection from the E-1 96-pin connector for Ports 22 to 42 to the external
balanced 120-ohm E-1 interfaces.
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Table 20-5: Pinout for E-1 Interfaces on Ports 22 to 42

Pin Signal
Wire Color
No. Name
TX 32
white-blue
1
N
TX 32
blue-white
2
P
TX 31
white-orange
3
N
TX 31
orange-white
4
P
TX 30
white-green
5
N
TX 30
6
green-white
P
TX 29
7
white-brown
N
TX 29
8
brown-white
P
TX 28
9
white-slate
N
TX 28
10
slate-white
P
TX 27
11
red-blue
N
TX 27
12
blue-red
P
TX 26
13
red-orange
N
14
orange-red

Pin Signal
Wire Color
No. Name
RX 32
white-blue
25
N
RX 32
blue-white
26
P
RX 31
white-orange
27
N
RX 31
orange-white
28
P
RX 30
white-green
29
N
RX 30
green-white
30
P
RX 29
31
white-brown
N
RX 29
32
brown-white
P
RX 28
33
white-slate
N
RX 28
34
slate-white
P
RX 27
35
red-blue
N
RX 27
36
blue-red
P
RX 26
37
red-orange
N
38
orange-red

Pin Signal
Wire Color
No. Name
TX 42
black-orange
49
N
TX 42
orange-black
50
P
TX 41
black-green
51
N
TX 41
green-black
52
P
TX 40
black-brown
53
N
TX 40
brown-black
54
P
TX 39
55
black-slate
N
TX 39
56
slate-black
P
TX 38
57
yellow-blue
N
TX 38
58
blue-yellow
P
TX 37
59
yellow-orange
N
TX 37
60
orange-yellow
P
TX 36
61
yellow-green
N
62
green-yellow

Table 20-4: Pinout for E-1 Interfaces on Ports 1 to 21

Pin Signal
Wire Color
No. Name
RX 42
black-orange
73
N
RX 42
orange-black
74
P
RX 41
black-green
75
N
RX 41
green-black
76
P
RX 40
black-brown
77
N
RX 40
78
brown-black
P
RX 39
79
black-slate
N
RX 39
80
slate-black
P
RX 38
81
yellow-blue
N
RX 38
82
blue-yellow
P
RX 37
83
yellow-orange
N
RX 37
84
orange-yellow
P
RX 36
85
yellow-green
N
86
green-yellow
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15
16
17
18
19
20
21
22
23
24

TX 26
P
TX 25
N
TX 25
P
TX 24
N
TX 24
P
TX 23
N
TX 23
P
TX 22
N
TX 22
P
-

red-green

39

green-red

40

red-brown

41

brown-red

42

red-slate

43

slate-red

44

black-blue

45

blue-black

46

-

47
48

RX 26
P
RX 25
N
RX 25
P
RX 24
N
RX 24
P
RX 23
N
RX 23
P
RX 22
N
RX 22
P
-

red-green

63

green-red

64

red-brown

65

brown-red

66

red-slate

67

slate-red

68

black-blue

69

blue-black
-

TX 36
P
TX 35
N
TX 35
P
TX 34
N
TX 34
P
TX 33
N
TX 33
P

yellow-brown 87
brown-yellow 88

RX 36
P
RX 35
N
RX 35
P
RX 34
N
RX 34
P
RX 33
N
RX 33
P

yellow-brown
brown-yellow

yellow-slate

89

yellow-slate

slate-yellow

90

violet-blue

91

blue-violet

92

-

-

93

-

-

70

-

-

94

-

-

71
72

-

-

95
96

-

-

slate-yellow
violet-blue
blue-violet

2. Tighten the screws of the cable connector to the FMEC connector.
3. Label all cables at each end of the connection to avoid confusion with cables that are similar in
appearance.
4. Return to your originating procedure (NTP).

DLP-D332 Install the TCC2/TCC2P Cards
Purpose

This task installs redundant TCC2/TCC2P cards. The first card you install in the ONS
15454 SDH must be a TCC2/TCC2P card, and it must initialize before you install any
cross-connect or traffic cards.
Two TCC2/TCC2P cards

Tools/Equipment
Prerequisite
None
Procedures
Required/As
Required
Needed
Onsite/Remote
Onsite
Security Level
None
Note: When installing cards, allow each card to boot completely before installing the next card.

1. Open the latches/ejectors of the TCC2/TCC2P card that you will install.
2. Use the latches/ejectors to firmly slide the card along the guide rails until the card plugs into the
receptacle at the back of the slot (Slot 7 or 11).
3. Verify that the card is inserted correctly and close the latches/ejectors on the card.
Note: It is possible to close the latches/ejectors when the card is not completely plugged into
the backplane. Ensure that you cannot insert the card any further.
If you insert a card into a slot provisioned for a different card, all LEDs turn off.
4. Go to SubStep 1 to verify the LED activity on the TCC2 card. For the TCC2P card, go to SubStep 2.
1. For the TCC2 card:
Table 20-5: Pinout for E-1 Interfaces on Ports 22 to 42
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◊ All LEDs turn on briefly. The red FAIL LED and the yellow ACT/STBY LED turn
on for about 15 seconds.
◊ The red FAIL LED and the green ACT/STBY LED turn on for about 40 seconds.
◊ The red FAIL LED blinks for about 15 seconds.
◊ The red FAIL LED turns on for about 15 seconds. All LEDs turn on for about 3
seconds before turning off for about 3 seconds.
◊ Both green PWR LEDs turn on for 10 seconds. The PWR LEDs then turn red for 2
to 3 minutes before going to steady green.
◊ While the PWR LEDs are red for two to three minutes, the ACT/STBY, MJ, and
MN LEDs turn on, followed by the SNYC LED.
◊ The boot up process is complete when the PWR LEDs turn green and the
ACT/STBY remains on. (The ACT/STBY LED will be green if this is the first
TCC2 card installed, and amber if this is the second TCC2 card installed.)
Note: It might take up to 4 minutes for the A and B power alarms to clear.
Note: Alarm LEDs might be on; disregard alarm LEDs until you are logged into CTC and
can view the Alarms tab.
Note: If you are logged into CTC, the SFTWDOWN alarm might appear as many as two
times while the TCC2 card initializes. The alarm should clear after the card completely
boots.
Note: If the FAIL LED is on continuously, see the tip below about the TCC2 card automatic
upload.
2. For the TCC2P card:
♦ All LEDs turn on briefly. The red FAIL LED, the yellow ACT/STBY LED,
the green SYNC LED, and the green ACO LED turn on for about 15
seconds.
♦ The red FAIL LED and the green ACT/STBY LED turn on for about 30
seconds.
♦ The red FAIL LED blinks for about 3 seconds.
♦ The red FAIL LED turns on for about 15 seconds.
♦ The red FAIL LED blinks for about 10 seconds and then becomes solid.
♦ All LEDs (including the CRIT, MAJ, MIN, REM, SYNC, and ACO LEDs)
blink once and turn off for about 5 seconds.
♦ Both green PWR LEDs turn on for 10 seconds. The PWR LEDs then turn
red for 2 to 3 minutes before going to steady green. During this time, the
ACT/STBY, MJ, and MN LEDs might turn on, followed by the SNYC LED
briefly.
♦ The boot up process is complete when the PWR LEDs turn green and the
yellow ACT/STBY remains on. (The ACT/STBY LED will be green if this
is the first TCC2 card installed, and yellow if this is the second TCC2 card
installed.)
Note: It might take up to 3 minutes for the A and B power alarms to clear.
Note: Alarm LEDs might be on; disregard alarm LEDs until you are logged into CTC and can view
the Alarms tab.
Note: If you are logged into CTC, the SFTWDOWN alarm might appear as many as two times while
the TCC2P card initializes. The alarm should clear after the card completely boots.
Note: If the FAIL LED is on continuously, see the tip below about the TCC2P card automatic
upload.
5. Verify that the ACT/STBY LED is green for active if this is the first powered-up TCC2/TCC2P card
installed, or yellow for standby if this is the second powered-up TCC2/TCC2P. The IP address,
temperature of the node, and time of day appear on the LCD. The default time and date is 12:00 AM,
January 1, 1970.
DLP-D332 Install the TCC2/TCC2P Cards
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6. The LCD cycles through the IP address (the default is 192.1.0.2), node name, and software version.
Verify that the correct software version displays on the LCD. The software text string indicates the
node type (SDH or SONET) and software release.(For example: SDH 07.00-05L-20.10 indicates it is
an SDH software load, Release 7.00. The numbers following the release number do not have any
significance.)
7. If the LCD shows the correct software version, continue with Step 8. If the LCD does not show the
correct software version, upgrade the software or remove the TCC2/TCC2P card and install a
replacement card.
Refer to the release-specific software upgrade document to replace the software. To
exchange the TCC2/TCC2P card, see the Cisco ONS 15454 SDH Troubleshooting Guide.
8. Repeat Steps 1 through 7 for the redundant TCC2/TCC2P card.
Tip: If you install a standby TCC2/TCC2P card that has a different software version than the
active TCC card, the newly installed standby TCC2/TCC2P card automatically copies the
software version from the active TCC2/TCC2P card. You do not need to do anything in this
situation, but the loading TCC2/TCC2P card does not boot up in the normal manner. When
the standby card is first inserted, the LEDs follow most of the sequence listed in Step 4.
However, after the red FAIL LED turns on for about 5 seconds, the FAIL LED and the
ACT/STBY LED begin to flash alternately for up to 30 minutes while the new software
loads onto the active TCC2/TCC2P card. After loading the new software, the upgraded
TCC2/TCC2P card's LEDs repeat the sequence from Step 4, and the amber ACT/STBY LED
turns on.
Note: If you insert a card into a slot provisioned for a different card, all LEDs turn off.
Note: Alarm LEDs might be on; disregard alarm LEDs until you are logged into CTC and
can view the Alarms tab.
9. Verify that the ACT/STBY LED is amber for standby.
10. Return to your originating procedure (NTP).

DLP-D333 Install the XC-VXL-10G, XC-VXL-2.5G, or XC-VXC-10G Cards
Purpose
This task installs the ONS 15454 SDH cross-connect cards.
Tools/Equipment
XC-VXL-10G, XC-VXL-2.5G, or XC-VXC-10G cards
Prerequisite Procedures DLP-D332 Install the TCC2/TCC2P Cards
Required/As Needed
Redundant cross-connect cards are required.
Onsite/Remote
Onsite
Security Level
None
Note: When installing cards, allow each card to boot completely before installing the next card.
Caution! The XC-VXL-2.5G cross-connect card only works for rates up to STM-16.
1. Open the latches/ejectors of the first XC-VXL-10G, XC-VXL-2.5G, or XC-VXC-10G card that you
will install.
2. Use the latches/ejectors to firmly slide the card along the guide rails until the card plugs into the
receptacle at the back of the slot (Slot 8 or 10).
3. Verify that the card is inserted correctly and close the latches/ejectors on the card.
Note: It is possible to close the latches/ejectors when the card is not completely plugged into
the back panel of the shelf assembly. Ensure that you cannot insert the card any further.
4. Verify the LED activity:
♦ The red LED turns on for 20 to 30 seconds.
DLP-D333 Install the XC-VXL-10G, XC-VXL-2.5G, or XC-VXC-10G Cards
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♦ The red LED blinks for 35 to 45 seconds.
♦ The red LED remains on for 5 to 10 seconds.
♦ All LEDs blink once and turn on.
♦ The ACT/STBY LED turns on.
Note: If you insert a card into a slot provisioned for a different card, all LEDs turn off.
Note: If the red FAIL LED does not turn on, check the power.
Note: If the red FAIL LED is on continuously or the LEDs act erratically, the card is not
installed properly. Remove the card and repeat Steps 1 to 4.
5. Verify that the ACT/STBY LED is green for active.
6. Use the latches/ejectors to firmly slide the second cross-connect card along the guide rails until the
card plugs into the receptacle at the back of the slot (Slot 8 or 10).
7. Verify that the card is inserted correctly and close the latches/ejectors on the card.
Note: It is possible to close the latches/ejectors when the card is not completely plugged into
the backplane. Ensure that you cannot insert the card any further.
8. Verify the LED activity:
♦ The red LED turns on for 20 to 30 seconds.
♦ The red LED blinks for 35 to 45 seconds.
♦ The red LED remains on for 5 to 10 seconds.
♦ All LEDs blink once and turn on.
♦ The ACT/STBY LED turns on.
Note: If you insert a card into a slot provisioned for a different card, all LEDs turn off.
Note: If the red FAIL LED does not turn on, check the power.
Note: If the red FAIL LED is on continuously or the LEDs act erratically, the card is not
installed properly. Remove the card and repeat Steps 6 to 8.
9. Verify that the ACT/STBY LED is amber for standby.
10. Return to your originating procedure (NTP).

DLP-D334 Install the Alarm Interface Controller-International Card
Purpose
Tools/Equipment
Prerequisite
Procedures

This task installs the AIC-I card. The AIC-I card provides connections for external
alarms and controls (environmental alarms).
AIC-I card
DLP-D332 Install the TCC2/TCC2P Cards

DLP-D333 Install the XC-VXL-10G, XC-VXL-2.5G, or XC-VXC-10G Cards
Required/As Needed As needed
Onsite/Remote
Onsite
Security Level
None
1. Open the latches/ejectors on the card.
2. Use the latches/ejectors to firmly slide the card along the guide rails until the card plugs into the
receptacle at the back of the slot (Slot 9).
3. Verify that the card is inserted correctly and close the latches/ejectors on the card.
Note: It is possible to close the latches/ejectors when the card is not completely plugged into
the backplane. Ensure that you cannot insert the card any further.
4. Verify the LED activity:
♦ The red FAIL LED turns on, then blinks for 1 to 5 seconds.
♦ The PWR A and PWR B LEDs become red and the two INPUT/OUTPUT LEDs become
green for approximately 3 seconds.
♦ The PWR A LED turns green, the INPUT/OUTPUT LEDs turn off, and the ACT LED turns
on.
DLP-D334 Install the Alarm Interface Controller-International Card
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Note: If the red FAIL LED does not illuminate, check the power.
Note: If you insert a card into a slot provisioned for a different card, all LEDs turn off.
Note: If the red FAIL LED is on continuously or the LEDs act erratically, the card is not
installed properly. Remove the card and repeat Steps 1 to 4.
5. Verify that the MIC-A/P provides connection for alarm contacts into and out of the shelf assembly.
For more information, see the "DLP-D324 Install Alarm Cables on the MIC-A/P" task.
6. Return to your originating procedure (NTP).

DLP-D335 Install GBIC or SFP/XFP Devices

Purpose

Tools/Equipment

This task installs Gigabit Interface Converters (GBICs), which are required
for E-Series Ethernet, G-Series Ethernet, CE-1000-4, and FC_MR-4 cards,
and Small Form-factor Pluggables (SFPs/XFPs), which are required for
CE-MR-10, ML1000-2, 15454_MRC-12 (MRC-12), OC192SR1/STM64IO
Short Reach (STM64-XFP Short Reach), OC192/STM64 Any Reach
(STM64-XFP Any Reach), and ML-MR-10 cards. SFPs/XFPs are
hot-swappable input/output devices that plug into a line card port to link the
port with the fiber-optic network. For a description of SFP/XFP devices on
transponder (TXP) or muxponder (MXP) cards, refer to the "Transponder
and Muxponder Cards" chapter in the Cisco ONS 15454 DWDM Reference
Manual.
For information on which GBICs, SFPs, and XFPs are compatible with
which cards, refer to the "Optical Cards" or "Ethernet Cards" chapters in the
Cisco ONS 15454 SDH Reference Manual.
DLP-D39 Install Ethernet Cards

Prerequisite Procedures
NTP-D286 Install the FC_MR-4 Cards
Required/As Needed
As needed
Onsite/Remote
Onsite
Security Level
None
Warning! Class 1 laser product. Statement 1008
Warning! Because invisible laser radiation may be emitted from the aperture of the port when no
cable is connected, avoid exposure to laser radiation and do not stare into open apertures. Statement
70
Note: OC192SR1/STM64IO Short Reach and OC192/STM64 Any Reach cards are listed as OC192-XFP
cards in CTC.
Note: The operating temperature of the DWDM GBICs is 23 degrees Fahrenheit (-5 degrees Celsius) to 104
degrees Fahrenheit (40 degrees Celsius).
Note: GBICs and SFPs are hot-swappable and can be installed or removed while the card or shelf assembly
is powered and running.
Note: All versions of GBICs used with the ONS 15454 SDH can be one of two types: with clips or with a
handle.
1. Remove the GBIC, SFP, or XFP from its protective packaging.
2. Check the label to verify that the GBIC, SFP, or XFP is the correct type for your network.

DLP-D335 Install GBIC or SFP/XFP Devices
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Note: Before you install SFPs on the MRC-12 card, refer to the MRC-12 card reference
section in the "Optical Cards" chapter of the Cisco ONS 15454 SDH Reference Manual for
bandwidth restrictions based on the port where you install the SFP and the cross-connect
card being used.
3. Verify the type of GBIC or SFP you are using:
⋅ If you are using a GBIC with clips, go to Step 4.
⋅ If you are using a GBIC with a handle, go to Step 5.
⋅ If you are using an SFP, go to Step 6.
4. For GBICs with clips:
1. Grip the sides of the GBIC with your thumb and forefinger and insert the GBIC into the slot
on the card (Figure 20-5).
Note: GBICs are keyed to prevent incorrect installation.
Figure 20-5: GBIC Installation (with Clips)

2. Slide the GBIC through the flap that covers the opening until you hear a click. The click
indicates that the GBIC is locked into the slot.
3. When you are ready to attach the network fiber-optic cable, remove the protective plug from
the GBIC, save the plug for future use, and install the fiber connector.
4. Continue with Step 8.
5. For GBICs with a handle:
1. Remove the protective plug from the SC-type connector.
2. Grip the sides of the GBIC with your thumb and forefinger and insert the GBIC into the slot
on the card.
Figure 20-5: GBIC Installation (with Clips)
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3. Lock the GBIC into place by closing the handle down. The handle is in the correct closed
position when it does not obstruct access to an SC-type connector.
4. Slide the GBIC through the cover flap until you hear a click.
The click indicates the GBIC is locked into the slot.
5. When you are ready to attach the network fiber-optic cable, remove the protective plug from
the GBIC, save the plug for future use, and install the fiber connector.
6. Continue with Step 8.
6. For SFPs/XFPs:
1. Plug the LC duplex connector of the fiber into a Cisco-supported SFP or XFP connector.
2. If the new SFP/XFP connector has a latch, close the latch over the cable to secure it.
3. Plug the cabled SFP/XFP connector into the card port until it clicks.
7. Multirate SFPs on the MRC-12 card must be provisioned in CTC. If the SFP was not preprovisioned,
complete the "DLP-D132 Provision a Multirate PPM on the MRC-12 and MRC-2.5G-12 Cards"
task.
8. Return to your originating procedure (NTP).

DLP-D336 Remove GBIC or SFP/XFP Device
Purpose
This task disconnects fiber attached to GBICs or SFPs/XFPs.
Tools/Equipment
None
Prerequisite Procedures DLP-D335 Install GBIC or SFP/XFP Devices
Required/As Needed
As needed
Onsite/Remote
Onsite
Security Level
None
Warning! Class 1 laser product. Statement 1008
Warning! Because invisible laser radiation may be emitted from the aperture of the port when no
cable is connected, avoid exposure to laser radiation and do not stare into open apertures. Statement
70
1. Disconnect the network fiber cable from the GBIC SC connector or SFP/XFP LC duplex connector.
If the SFP/XFP connector has a latch securing the fiber cable, pull it upward to release the cable.
2. If you are using a GBIC with clips:
1. Release the GBIC from the slot by simultaneously squeezing the two plastic tabs on each
side of it.
2. Slide the GBIC or SFP/XFP out of the Gigabit Ethernet module slot. A flap closes over the
GBIC or SFP/XFP slot to protect the connector on the Gigabit Ethernet card.
3. If you are using a GBIC with a handle:
1. Release the GBIC by opening the handle.
2. Pull the handle of the GBIC.
3. Slide the GBIC out of the card slot. A flap closes over the GBIC slot to protect the connector
on the card.
4. If you are using an SFP/XFP:
1. If the SFP/XFP connector has a latch securing the fiber cable, pull it upward to release the
cable.
2. Pull the fiber cable straight out of the connector.
3. Unplug the SFP/XFP connector and fiber from the card.
4. Slide the SFP/XFP out of the card slot.
5. Return to your originating procedure (NTP).

DLP-D336 Remove GBIC or SFP/XFP Device
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DLP-D337 Install Fiber-Optic Cables for SNCP Configurations
Purpose

This task connects the fiber-optic cables to the east and west SNCP ports at each
node. See Turn Up a Network to provision and test SNCP configurations.
Fiber-optic cables

Tools/Equipment
Prerequisite
NTP-D112 Clean Fiber Connectors
Procedures
Required/As Needed Required
Onsite/Remote
Onsite
Security Level
None
Note: To avoid error, connect fiber-optic cable so that the farthest slot to the right represents the east port,
and the farthest slot to the left represents the west port. Fiber connected to an east port at one node must plug
into the west port at an adjacent node.
Caution! Do not provision the SNCP east and west ports on the same STM-N card.
1. Plan your fiber connections. Use the same plan for all SNCP nodes.
2. Plug the fiber into the transmit (Tx) connector of an STM-N card at one node and plug the other end
of the fiber into the receive (Rx) connector of an STM-N card at the adjacent node. The card displays
an SF LED if the transmit and receive fibers are mismatched (one fiber connects a receive port on
one card to a receive port on another card, or the same situation with transmit ports).
3. Repeat Step 2 until you have configured the ring.
Figure 20-6 shows fiber connections for a four-node SNCP with trunk (span) cards in Slot 5 (west)
and Slot 12 (east).
Figure 20-6: Connecting Fiber to a Four-Node SNCP

Figure 20-7 shows an SNCP dual-ring interconnect (DRI) example.

DLP-D337 Install Fiber-Optic Cables for SNCP Configurations
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Figure 20-7: Connecting Fiber to an Eight-Node SNCP DRI

Figure 20-8 shows an integrated SNCP DRI example.
Figure 20-8: Connecting Fiber to a Six-Node Integrated SNCP DRI

Figure 20-7: Connecting Fiber to an Eight-Node SNCP DRI
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4. Return to your originating procedure (NTP).

DLP-D338 Install Fiber-Optic Cables for MS-SPRing Configurations
Purpose

This task installs the fiber optic cables to the east and west MS-SPRing ports at each
node. See Turn Up a Network to provision and test MS-SPRing configurations.
Fiber-optic cables

Tools/Equipment
Prerequisite
NTP-D112 Clean Fiber Connectors
Procedures
Required/As Needed As needed
Onsite/Remote
Onsite
Security Level
None
Note: To avoid error, connect fiber-optic cable so that the farthest slot to the right represents the east port,
and the farthest slot to the left represents the west port. Fiber connected to an east port at one node must plug
into the west port at an adjacent node.
Caution! Do not provision MS-SPRing east and west ports on the same STM-N card.
1. Plan your fiber connections. Use the same plan for all MS-SPRing nodes.
2. Plug the fiber into the Tx connector of an STM-N card at one node and plug the other end into the Rx
connector of an STM-N card at the adjacent node. The card displays a SF LED if the transmit and
receive fibers are mismatched.

Figure 20-8: Connecting Fiber to a Six-Node Integrated SNCP DRI
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Note: Do not mix working and protect card connections when connecting a four-fiber
MS-SPRing. The MS-SPRing does not function if working and protect cards are
interconnected. See Figure 20-10 for an example of correct four-fiber MS-SPRing cabling.
3. Repeat Step 2 until you have configured the ring.
Figure 20-9 shows fiber connections for a two-fiber MS-SPRing with trunk (span) cards in
Slot 5 (west) and Slot 12 (east).
Figure 20-9: Connecting Fiber to a Four-Node, Two-Fiber MS-SPRing

Figure 20-10 shows fiber connections for a four-fiber MS-SPRing. Slot 5 (west) and Slot 12 (east)
carry the working traffic. Slot 6 (west) and Slot 13 (east) carry the protect traffic.
Figure 20-10: Connecting Fiber to a Four-Node, Four-Fiber MS-SPRing

DLP-D338 Install Fiber-Optic Cables for MS-SPRing Configurations
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4. Return to your originating procedure (NTP).

DLP-D340 Change Line and Threshold Settings for the E3-12 Cards
This task changes the line and threshold settings for the E3-12
cards.
Tools/Equipment
None
Prerequisite Procedures
DLP-D60 Log into CTC
Required/As Needed
As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: For the default values and domains of user-provisionable card settings, refer to the "Network Element
Defaults" appendix in the Cisco ONS 15454 SDH Reference Manual.
Purpose

1. In node view, double-click the E3-12 card where you want to change the line or threshold settings.
2. Click the Provisioning tab.
3. Depending on the setting you need to modify, click the Line, Line Thresholds, Elect Path
Thresholds, or SDH Thresholds subtab.
Note: See Manage Alarms for information about the Alarm Profiles tab.
Note: If you want to modify a threshold setting, it might be necessary to click on the
available directional, type, and interval (15 Min, 1 Day) radio buttons and then click
Refresh. This will display the desired threshold setting.
4. Modify any of the settings found under these subtabs by clicking in the field you want to modify. In
some fields you can choose an option from a drop-down list; in others you can type a value or select
or deselect a check box.
5. Click Apply.
6. Repeat Steps 3 through 5 for each subtab that has parameters you want to provision.

Figure 20-10: Connecting Fiber to a Four-Node, Four-Fiber MS-SPRing
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For definitions of the line settings, see Table 20-6. For definitions of the line threshold
settings, see Table 20-7. For definitions of the electrical path threshold settings, see Table
20-8. For definitions of the SDH threshold settings, see Table 20-9.
Table 20-6 describes the values on the Provisioning > Line tab for the E3-12 cards.
Table 20-6: Line Options for E3-12 Cards

Parameter
Description
Port
(Display only) Port number.
Port Name Port name.

Options
1 to 12
User-defined, up to 32 alphanumeric/special characters. Blank
by default.
See the "DLP-D314 Assign a Name to a Port" task.

SF BER

Sets the signal fail bit error rate.

SD BER

Sets the signal degrade bit error
rate.

Admin
State

Sets the port service state unless
network conditions prevent the
change. For more information
about administrative states, refer
to the "Administrative and
Service States" appendix of the
Cisco ONS 15454 SDH
Reference Manual.

• 1E-3
• 1E-4
• 1E-5
• 1E-5
• 1E-6
• 1E-7
• 1E-8
• 1E-9
• Unlocked-Puts the port in service. The port service
state changes to Unlocked-enabled.
• Unlocked,automaticInService-Puts the port in
automatic in-service. The port service state changes
to Unlocked-disabled,automaticInService.
• Locked,disabled-Removes the port from service and
disables it. The port service state changes to
Locked-enabled,disabled.
• Locked,maintenance-Removes the port from service
for maintenance. The port service state changes to
Locked-enabled,maintenance.
Note: CTC will not allow you to change a port service state
from Unlocked-enabled to Locked-enabled,disabled. You
must first change a port to the Locked-enabled,maintenance
service state before putting it in the Locked-enabled,disabled
service state.

Service
State

(Display only) Identifies the
autonomously generated state
that gives the overall condition
of the port. Service states appear
in the format: Primary
State-Primary State Qualifier,
Secondary State. For more
information about service states,
refer to the "Administrative and
Service States" appendix of the
Cisco ONS 15454 SDH

• Unlocked-enabled-The port is fully operational and
performing as provisioned.
• Unlocked-disabled,automaticInService-The port is
out-of-service, but traffic is carried. Alarm reporting
is suppressed. The ONS node monitors the ports for
an error-free signal. After an error-free signal is
detected, the port stays in the
Unlocked-disabled,automaticInService state for the
duration of the soak period. After the soak period
ends, the port service state changes to

DLP-D340 Change Line and Threshold Settings for the E3-12 Cards
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Reference Manual.

Sets the automatic in-service
AINS Soak
soak period.

Unlocked-enabled.
• Locked-enabled,disabled-The port is out-of-service
and unable to carry traffic.
• Locked-enabled,maintenance-The port is
out-of-service for maintenance. Alarm reporting is
suppressed, but traffic is carried and loopbacks are
allowed.
• Duration of valid input signal, in hh.mm format, after
which the card becomes Unlocked-enabled
automatically
• 0 to 48 hours, 15-minute increments

Table 20-7 describes the values on the Provisioning > Line Thresholds tab for the E3-12 cards. Only
near-end line threshold options are supported for this card.
Table 20-7: Line Threshold Options for E3-12 Cards

Parameter
Port
CV
ES
SES
LOSS
15 Min radio
button
1 Day radio
button

Description
(Display only) Port number; 1 to 12.
Coding violations.
Errored seconds.
Severely errored seconds.
Loss of signal seconds; number of one-second intervals containing one or more LOS
defects.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 15-minute intervals.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 1-day intervals.

Table 20-8 describes the values on the Provisioning > Elect Path Thresholds tab for the E3-12 cards.
Table 20-8: Electrical Path Threshold Options for E3-12 Cards

Parameter
Port
ES
SES
UAS
15 Min radio
button
1 Day radio
button

Description
(Display only) E-3 ports; 1 to 12.
Errored seconds.
Severely errored seconds.
Unavailable seconds.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 15-minute intervals.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 1-day intervals.

Table 20 describes the values on the Provisioning > SDH Thresholds tab for the E3-12 cards.
Table 20-9: SDH Threshold Options for E3-12 Cards

Parameter

Table 20-6: Line Options for E3-12 Cards

Description
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Port
ES
SES
EB
UAS
BBE
15 Min radio
button
1 Day radio
button

(Display only) E-3 ports; 1 to 12.
Errored seconds.
Severely errored seconds.
Errored blocks.
Unavailable seconds.
Background block errors.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 15-minute intervals.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 1-day intervals.

Note: The threshold value appears after the circuit is created.
7. Return to your originating procedure (NTP).

DLP-D341 Change Line and Threshold Settings for the DS3i-N-12 Cards
This task changes the line and threshold settings for the DS3i-N-12
cards.
Tools/Equipment
None
Prerequisite Procedures
DLP-D60 Log into CTC
Required/As Needed
As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: For the default values and domains of user-provisionable card settings, refer to the "Network Element
Defaults" appendix in the Cisco ONS 15454 SDH Reference Manual.
Purpose

1. In node view, double-click the DS3i-N-12 card where you want to change the line or threshold
settings.
2. Click the Provisioning tab.
3. Depending on the setting you need to modify, click the Line, Line Thresholds, Elect Path
Thresholds, or SDH Thresholds subtab.
Note: See Manage Alarms for information about the Alarm Profiles tab.
Note: If you want to modify a threshold setting, it might be necessary to click on the
available directional, type, and interval (15 Min, 1 Day) radio buttons and then click
Refresh. This will display the desired threshold setting.
4. Modify any of the settings found under these subtabs by clicking in the field you want to modify. In
some fields you can choose an option from a drop-down list; in others you can type a value or select
or deselect a check box.
5. Click Apply.
6. Repeat Steps 3 through 5 for each subtab that has parameters you want to provision.
For definitions of the line settings, see Table 20-10. For definitions of the line threshold
settings, see Table 20-11. For definitions of the electrical path threshold settings, see Table
20-12. For definitions of the SDH threshold settings, see Table 20-13.
Table 20-10 describes the values on the Provisioning > Line tab for the DS3i-N-12 cards.
Table 20-10: Line Options for the DS3i-N-12 Card

Parameter
Port

Description

Options
1 to 12

Table 20-9: SDH Threshold Options for E3-12 Cards
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(Display only) Displays the port
number.
Port Name Sets the port name.

User-defined, up to 32 alphanumeric/special characters.
Blank by default.
See the "DLP-D314 Assign a Name to a Port" task.

SF BER

Sets the signal fail bit error rate.

SD BER

Sets the signal degrade bit error
rate.

• 1E-3
• 1E-4
• 1E-5
• 1E-5
• 1E-6
• 1E-7
• 1E-8
• 1E-9
• Unframed
• M13
• C Bit
• Auto Provisioned

Line Type Defines the line framing type.

• Unframed
• M13
• C Bit
• Auto Provisioned

Detected
(Display only) Displays the
Line Type detected line type.
Line
Coding
Line
Length

Admin
State

(Display only) Defines the DS3E
B3ZS
transmission coding type.
Defines the distance (in feet) from
backplane connection to the next
• 0 - 225 (Default)
termination point.
• 226 - 450The o
• Unlocked-Puts the port in service. The port service
state changes to Unlocked-enabled.
• Unlocked,automaticInService-Puts the port in
automatic in-service. The port service state changes
to Unlocked-disabled,automaticInService.
• Locked,disabled-Removes the port from service
and disables it. The port service state changes to
Locked-enabled,disabled.
• Locked,maintenance-Removes the port from
service for maintenance. The port service state
changes to Locked-enabled,maintenance.

Sets the port service state unless
network conditions prevent the
change. For more information
about administrative states, refer to
the "Administrative and Service
States" appendix of the Cisco ONS
15454 SDH Reference Manual.

Note: CTC will not allow you to change a port service state
from Unlocked-enabled to Locked-enabled,disabled. You
must first change a port to the Locked-enabled,maintenance
service state before putting it in the
Locked-enabled,disabled service state.
Service
State

(Display only) Identifies the
autonomously generated state that

Table 20-10: Line Options for the DS3i-N-12 Card
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gives the overall condition of the
port. Service states appear in the
format: Primary State-Primary
State Qualifier, Secondary State.
For more information about
service states, refer to the
"Administrative and Service
States" appendix of the Cisco ONS
15454 SDH Reference Manual.

Sets the automatic in-service soak
AINS Soak
period.

• Unlocked-enabled-The port is fully operational and
performing as provisioned.
• Unlocked-disabled,automaticInService- The port is
out-of-service, but traffic is carried. Alarm
reporting is suppressed. The ONS node monitors
the ports for an error-free signal. After an error-free
signal is detected, the port stays in the
Unlocked-disabled,automaticInService state for the
duration of the soak period. After the soak period
ends, the port service state changes to
Unlocked-enabled.
• Locked-enabled,disabled-The port is out-of-service
and unable to carry traffic.
• Locked-enabled,maintenance-The port is
out-of-service for maintenance. Alarm reporting is
suppressed, but traffic is carried and loopbacks are
allowed.
• Duration of valid input signal, in hh.mm format,
after which the card becomes in Unlocked-enabled
automatically
• 0 to 48 hours, 15-minute increments

Table 20-11 describes the values on the Provisioning > Line Thresholds tab for the DS3i-N-12 cards.
Only near-end line threshold options are supported for this card.
Table 20-11: Line Threshold Options for the DS3i-N-12 Cards

Parameter
Port
CV
ES
SES
LOSS
15 Min radio
button
1 Day radio
button

Description
(Display only) Port number; 1 to 12.
Coding violations.
Errored seconds.
Severely errored seconds.
Loss of signal seconds; number of one-second intervals containing one or more LOS
defects.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 15-minute intervals.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 1-day intervals.

Table 20-12 describes the parameters on the Provisioning > Elect Path Thresholds tab for the
DS3i-N-12 cards.
Table 20-12: Electrical Path Options for the DS3i-N-12 Cards

Parameter
Port
CVP

Description
(Display only) Port number; Port 1 to 12.
Coding violations - path. Available for DS3 Pbit, Near End only; and for DS3 CPbit, Near
End and Far End.

ESP
Table 20-11: Line Threshold Options for the DS3i-N-12 Cards
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SESP
SASP
UASP
AISSP
15 Min radio
button
1 Day radio
button

Errored seconds - path. Available for DS3 Pbit, Near End only; and for DS3 CPbit, Near
End and Far End.
Severely errored seconds - path. Available for DS3 Pbit, Near End only; and for DS3
CPbit, Near End and Far End.
Severely errored frame/alarm indication signal - path. Available for DS3 Pbit, Near End
only; and for DS3 CPbit, Near End and Far End.
Unavailable seconds - path. Available for DS3 Pbit, Near End only; and for DS3 CPbit,
Near End and Far End.
Alarm indication signal seconds - path. Available for DS3 Pbit, Near End only; and for
DS3 CPbit, Near End and Far End.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 15-minute intervals.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 1-day intervals.

Table 20-13 describes the values on the Provisioning > SDH Thresholds tab for the DS3i-N-12 cards.
Table 20-13: SDH Threshold Options for DS3i-N-12 Cards

Parameter
Port
ES
SES
EB
UAS
BBE
15 Min radio
button
1 Day radio
button

Description
(Display only) Port number; 1 to 12.
Errored seconds. Available for Near End and Far End, VC LO or VC4.
Severely errored seconds. Available for Near End and Far End, VC LO or VC4.
Errored blocks. Available for Near End and Far End, VC LO or VC4.
Unavailable seconds. Available for Near End and Far End, VC LO or VC4.
Background block errors. Available for Near End and Far End, VC LO or VC4.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 15-minute intervals.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 1-day intervals.

Note: The threshold value appears after the circuit is created.
7. Return to your originating procedure (NTP).

DLP-D342 Change Line and Threshold Settings for the STM1E-12 Card
Purpose
This task changes the line and threshold settings for the STM1E-12 card.
Tools/Equipment
None
Prerequisite Procedures DLP-D60 Log into CTC
Required/As Needed
As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: For the default values and domains of user-provisionable card settings, refer to the "Network Element
Defaults" appendix in the Cisco ONS 15454 SDH Reference Manual.
1. In node view, double-click the STM1E-12 card where you want to change the line or threshold
settings.
Table 20-12: Electrical Path Options for the DS3i-N-12 Cards
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2. Click the Provisioning tab.
3. Depending on the setting you need to modify, click the Line, Port, SDH Thresholds, or VC4
subtab.
Note: See Manage Alarms for information about the Alarm Profiles tab.
Note: If you want to modify a threshold setting, it might be necessary to click on the
available directional, type, and interval (15 Min, 1 Day) radio buttons and then click
Refresh. This will display the desired threshold setting.
4. Modify any of the settings found under these subtabs by clicking in the field you want to modify. In
some fields you can choose an option from a drop-down list; in others you can type a value or select
or deselect a check box.
5. Click Apply.
6. Repeat Steps 3 through 5 for each subtab that has parameters you want to provision.
7. For definitions of the line settings, see Table 20-14. For definitions of the port settings, see Table
20-15. For definitions of the threshold settings, see Table 20-16. For definitions of the VC4 settings,
see Table 20-17.
Table 20-14 describes the values on the Provisioning > Line tab for the STM1E-12 cards.
Table 20-14: Line Options for the STM1E-12 Card

Parameter
Description
Port
(Display only) Port number.
Port Name

(Optional) Sets the name
assigned to the port.

Options
1 to 12
User-defined, up to 32 alphanumeric/special characters.
Blank by default.
See the "DLP-D314 Assign a Name to a Port" task.

Sets the signal fail bit error rate
SF Ber Level for the configured VC12 or VC4
circuit.

Sets the signal degrade bit error
SD Ber Level rate for the configured VC12 or
VC4 circuit.
Admin State Sets the port service state unless
(Status)
network conditions prevent the
change. For more information
about administrative states, refer
to the "Administrative and
Service States" appendix of the
Cisco ONS 15454 SDH Reference
Manual.

• 1E-3
• 1E-4
• 1E-5
• 1E-5
• 1E-6
• 1E-7
• 1E-8
• 1E-9
• Unlocked-Puts the port in service. The port service
state changes to Unlocked-enabled.
• Unlocked,automaticInService-Puts the port in
automatic in-service. The port service state
changes to
Unlocked-disabled,automaticInService.*
Locked,disabled-Removes the port from service
and disables it. The port service state changes to
Locked-enabled,disabled.
• Locked,maintenance-Removes the port from
service for maintenance. The port service state
changes to Locked-enabled,maintenance.
Note: CTC will not allow you to change a port service
state from Unlocked-enabled to Locked-enabled,disabled.
You must first change a port to the

DLP-D342 Change Line and Threshold Settings for the STM1E-12 Card
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Locked-enabled,maintenance service state before putting it
in the Locked-enabled,disabled service state.
Sets the VC4 that will be used for
pointer justification. If set to Off,
PJVC4Mon# no VC4 is monitored. Only one
VC4 can be monitored on each
STM-N port.

AINS Soak

• Off
•1

• Duration of valid input signal, in hh.mm format,
after which the card becomes Unlocked-enabled
automatically
• 0 to 48 hours, 15-minute increments

Sets the automatic in-service soak
period.

Table 20-15 describes the values on the Provisioning > Port tab for the STM1E-12 cards.
Table 20-15: Port Options for the STM1E-12 Card

Parameter
Port

Description
(Display only) Port number

Interface

Interface type

Options
1 to 12
• STM1 (display only for Ports 1 through 8, selectable
for Ports 9 through 12)

Table 20-16 describes the values on the Provisioning > SDH Thresholds tab for the STM1E-12
cards.
Table 20-16: Threshold Options for the STM1E-12 Card

Parameter
Port
ES
SES
BBE
UAS
EB
15 Min radio
button
1 Day radio
button

Description
(Display only) Port number; 1 to 12.
Errored seconds.
Severely errored seconds.
Background block errors.
Unavailable seconds.
Errored blocks.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 15-minute intervals.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 1-day intervals.

Table 20-17 describes the values on the Provisioning > VC4 tab for the STM1E-12 cards.
Table 20-17: VC4 Options for the STM1E-12 Card

Parameter
Description
VC4 #
(Display only) VC4 container number.
Enable
Sets intermediate path performance monitoring (IPPM).
IPPM
Note: To provision IPPM, circuits must be provisioned on the STM1E-12 card. For
circuit creation procedures, go to Create Circuits and Low-Order Tunnels. To
Table 20-14: Line Options for the STM1E-12 Card

Options
1 to 12
-
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provision IPPM, go to the "DLP-D121 Enable Pointer Justification Count
Performance Monitoring" task.
SF Ber
Level

SD Ber
Level

Sets the signal fail bit error rate for the configured VC12 or VC4 circuit.

Sets the signal degrade bit error rate for the configured VC12 or VC4 circuit.

• 1E-3
• 1E-4
• 1E-5
• 1E-5
• 1E-6
• 1E-7
• 1E-8
• 1E-9

8. Return to your originating procedure (NTP).

DLP-D343 Change SDH Threshold Settings for STM-N Cards
Purpose
This task changes threshold settings for STM-N cards.
Tools/Equipment
None
Prerequisite Procedures DLP-D60 Log into CTC
Required/As Needed
As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: For the default values and domains of user-provisionable card settings, refer to the "Network Element
Defaults" appendix in the Cisco ONS 15454 SDH Reference Manual.
1. In node view, double-click the STM-N card where you want to change the SDH threshold settings.
2. Click the Provisioning > SDH Thresholds tabs.
Note: If you want to modify a threshold setting, it might be necessary to click on the
available directional, type, and interval (15 Min, 1 Day) radio buttons and then click
Refresh. This will display the desired threshold setting.
3. Modify any of the settings listed in Table 20-18 by clicking in the field you want to modify. In some
fields you can choose an option from a drop-down list; in others you can type a value or select or
deselect a check box.
4. Click Apply.
Table 20-18: STM-N Threshold Options

Parameter

Description
(Display only) Port number.

Port

EB
ES
SES
BBE
UAS

• 1 (STM-4, STM-16, STM-64)
• 1 to 4 (OC3 IR 4/STM1 SH 1310, OC12 IR/STM4 SH 1310-4)
• 1 to 8 (OC3IR/STM1SH 1310-8)
• 1 to 12: PPM-1 (MRC-12)
Errored blocks. Available for Near End and Far End, VC LO or VC4.
Errored seconds. Available for Line, Section, or Path; Near End and Far End.
Severely errored seconds. Available for Line, Section, or Path; Near End and Far End.
Background block errors. Available for Near End and Far End, VC LO or VC4.
Unavailable seconds. Available for Line or Path; Near End and Far End.

Table 20-17: VC4 Options for the STM1E-12 Card
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PPJC-PDET
NPJC-PDET
PPJC-PGEN
NPJC-PGEN
PSC
PSD
PSC-W

PSD-W

PSC-S

PSD-S

PSC-R

PSD-R
15 Min radio
button
1 Day radio
button

Positive Pointer Justification Count, STS Path Detected. Available for Line; Near End and
Far End.
Negative Pointer Justification Count, STS Path Detected. Available for Line; Near End
and Far End.
Positive Pointer Justification Count, STS Path Generated. Available for Line; Near End
and Far End.
Negative Pointer Justification Count, STS Path Generated. Available for Line; Near End
and Far End.
Protection Switching Count (Line). Available for Line; Near End and Far End.
Protection Switch Duration (Line). Available for Line; Near End and Far End.
Protection Switching Count-Working Line. Available for Line; Near End and Far End.
Note: MS-SPRing is not supported on the STM-1 card; therefore, the PSC-W
performance monitoring (PM) parameter does not increment.
Protection Switching Duration-Working Line. Available for Line; Near End and Far End.
Note: MS-SPRing is not supported on the STM-1 card; therefore, the PSD-WPM
parameter does not increment.
Protection Switching Count-Span. Available for Line; Near End and Far End.
Note: MS-SPRing is not supported on the STM-1 card; therefore, the PSC-S PM
parameter does not increment.
Protection Switching Duration-Span. Available for Line; Near End and Far End.
Note: MS-SPRing is not supported on the STM-1 card; therefore, the PSD-S PM
parameter does not increment.
Protection Switching Count-Ring. Available for Line; Near End and Far End.
Note: MS-SPRing is not supported on the STM-1 card; therefore, the PSC-R PM
parameter does not increment.
Protection Switching Duration-Ring. Available for Line; Near End and Far End.
Note: MS-SPRing is not supported on the STM-1 card; therefore, the PSD-R PM
parameter does not increment.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 15-minute intervals.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 1-day intervals.

5. Return to your originating procedure (NTP).

DLP-D348 View ML-Series Ether Ports PM Parameters
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote

This task enables you to view ML-Series Ethernet port PM counts at selected
time intervals to detect possible performance problems.
None
DLP-D60 Log into CTC
As needed
Onsite or remote

Table 20-18: STM-N Threshold Options
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Security Level
Retrieve or higher
Note: For ML-Series card provisioning, refer to the Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet
Card Software Feature and Configuration Guide.
1. In node view, double-click the ML-Series Ethernet card where you want to view PM counts. The
card view appears.
2. Click the Performance > Ether Ports tabs (Figure 20-11).
Figure 20-11: Ether Ports on the Card View Performance Window

3. Click Refresh. PM statistics for each port on the card appear.
4. View the PM parameter names that appear in the Param column. The PM parameter values appear in
the Port # columns. For PM parameter definitions, refer to the "Performance Monitoring" chapter in
the Cisco ONS 15454 SDH Reference Manual.
Note: To refresh, reset, or clear PM counts, see the NTP-D257 Change the PM Display.
5. Return to your originating procedure (NTP).

DLP-D349 View ML-Series POS Ports PM Parameters
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As
Needed
Onsite/Remote
Security Level

This task enables you to view packet-over-SDH (POS) port PM counts at selected
time intervals on an ML-Series Ethernet card and port to detect possible performance
problems.
None
DLP-D60 Log into CTC
As needed
Onsite or remote
Retrieve or higher

DLP-D348 View ML-Series Ether Ports PM Parameters
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Note: For ML-Series card provisioning, refer to the Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet
Card Software Feature and Configuration Guide.
1. In node view, double-click the ML-Series Ethernet card where you want to view PM counts. The
card view appears.
2. Click the Performance > POS Ports tabs (Figure 20-12).
Figure 20-12: POS Ports on the Card View Performance Window

3. Click Refresh. Performance monitoring statistics for each port on the card appear.
4. View the PM parameter names that appear in the Param column. The PM parameter values appear in
the Port # columns. For PM parameter definitions, refer to the "Performance Monitoring" chapter in
the Cisco ONS 15454 SDH Reference Manual.
Note: To refresh, reset, or clear PM counts, see the NTP-D257 Change the PM Display.
5. Return to your originating procedure (NTP).

DLP-D353 Provision G-Series Flow Control Watermarks
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

This task provisions the buffer memory levels for flow control on G-Series
Ethernet ports.
None
DLP-D60 Log into CTC
As needed
Onsite or remote
Provisioning or higher

1. In node view, double-click the G-Series card graphic to open the card.
2. Click the Provisioning > Port tabs.
DLP-D349 View ML-Series POS Ports PM Parameters
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3. In the Water Marks column, click the cell in the row for the appropriate port.
4. To provision the Low Latency flow control watermark:
1. Choose Low Latency from the drop-down list.
The Flow Ctrl Lo and Flow Ctrl Hi values change.
2. Click Apply.
5. To provision a Custom flow control watermark:
1. Choose Custom from the drop-down list.
2. In the Flow Ctrl Lo column, click the cell in the row for the appropriate port.
3. Enter a value in the cell. The Flow Ctrl Lo value has a valid range from 1 to 510 and must be
lower than the Flow Ctrl Hi value.
This value sets the flow control threshold for sending the signal to the attached
Ethernet device to resume transmission.
4. In the Flow Ctrl Hi column, click the cell in the row for the appropriate port.
5. Enter a value in the cell. The Flow Ctrl Hi value has a valid range from 2 to 511 and must be
higher than the Flow Ctrl Lo value.
This value sets the flow control threshold for sending the signal to the attached
Ethernet device to pause transmission.
6. Click Apply.
Note: Low watermarks are optimum for low latency subrate applications, such as
voice-over-IP (VoIP). High watermarks are optimum when the attached Ethernet device has
insufficient buffering, best effort traffic, or long access line lengths.
6. Return to your originating procedure (NTP).

DLP-D354 Change General Port Settings for the FC_MR-4 Card
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

This task changes the general port settings for FC_MR-4 cards.
None
DLP-D60 Log into CTC
As needed
Onsite or remote
Provisioning or higher

1. In node view, double-click the FC_MR-4 card where you want to change the port settings.
2. Click the Provisioning > Port > General tabs.
3. Modify any of the settings described in Table 20-19.
Table 20-19: FC_MR-4 Card General Port Settings

Parameter
Port
Port Name

Description
Options
(Display only) Displays the port number. 1 through 4
Provides the ability to assign the specified User-defined. Name can be up to 32
port a name.
alphanumeric/special characters. Blank by
default.
See the "DLP-D314 Assign a Name to a
Port" task.
Note: If this port's Fibre Channel or
FICON link will be discovered by the
Cisco MDS Fabric Manager for use with a
Cisco MDS 9000 switch, you must

DLP-D353 Provision G-Series Flow Control Watermarks
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provision the Fiber Channel/FICON port
name to the following string: FC: switch>
interface> Where switch> is the DNS name
or IPv4/v6 address of the Cisco MDS 9000
switch, and interface> is the card slot/port
of the FC_MR-4 port you are assigning a
name. Example: FC: 10.0.0.1 fc2/4

Admin State

• Unlocked-Puts the port in service.
The port service state changes to
Unlocked-enabled.
• Locked,disabled-Removes the port
from service and disables it. The
port service state changes to
Locked-enabled,disabled.
• Locked,maintenance-Removes the
port from service for maintenance.
The port service state changes to
Locked-enabled,maintenance.

Changes the port service state unless
network conditions prevent the change.

Note: CTC will not allow you to change a
port service state from Unlocked-enabled
to Locked-enabled,disabled. You must first
change a port to the
Locked-enabled,maintenance service state
before putting it in the
Locked-enabled,disabled service state.

Service State

Identifies the autonomously generated
state that gives the overall condition of the
port. Service states appear in the format:
Primary State-Primary State Qualifier,
Secondary State.

Port Rate

Selects the Fibre Channel interface.

Link Rate

Displays the actual rate of the port.
Displays the maximum GBIC rate. Cisco
supports two GBICs for the FC_MR-4
card (ONS-GX-2FC-SML and
ONS-GX-2FC-MMI). If used with another
GBIC, the field shows "Contact GBIC
vendor."
Enables or disables link recovery if a local port is inoperable. If enabled, a link reset

Max GBIC Rate

Link Recovery

Table 20-19: FC_MR-4 Card General Port Settings

• Unlocked-enabled-The port is fully
operational and performing as
provisioned.
• Locked-enabled,disabled-The port
is out-of-service and unable to
carry traffic.
• Locked-enabled,maintenance-The
port is out-of-service for
maintenance. Alarm reporting is
suppressed, but traffic is carried
and loopbacks are allowed.
• 1 Gbps
• 2 Gbps
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occurs when there is a loss of transport
from a cross-connect switch, protection
switch, or an upgrade.

Media Type

Sets the proper payload value for the
Transparent Generic Framing Protocol
(GFP-T) frames.

• Fibre Channel - 1 Gbps
• Fibre Channel - 2 Gbps
• FICON 1 Gbps
• FICON 2 Gbps
• Unknown

4. Click Apply.
5. Return to your originating procedure (NTP).

DLP-D355 Change Distance Extension Port Settings for the FC_MR-4 Card
This task changes the distance extension parameters for FC_MR-4
ports.
Tools/Equipment
None
Prerequisite Procedures
DLP-D60 Log into CTC
Required/As Needed
As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: For the default values and domains of user-provisionable card settings, refer to the "Network Element
Defaults" appendix in the Cisco ONS 15454 SDH Reference Manual.
Purpose

1. In node view, double-click the FC_MR-4 card where you want to change the port settings.
2. Click the Provisioning > Port > Distance Extension tabs.
3. Modify any of the settings described in Table 20-20 by clicking in the field you want to modify. In
some fields you can choose an option from a drop-down list; in others you can type a value or select
or deselect a check box.
Table 20-20: FC_MR-4 Card Distance Extension Port Settings

Parameter
Description
Options
Port
(Display only) The card port number.
1 through 4
If checked, allows additional distance by providing a GFP-T based flow
control scheme. It enables the node to be a part of a Storage Area Network
Enable
(SAN) with long-distance, remote nodes. If left unchecked, the remaining
options are not available for editing. If Distance Extension is enabled, set the Distance
Extension
connected Fibre Channel switches to Interop or Open Fabric mode, depending
on the Fibre Channel switch. By default, the FC_MR-4 card will interoperate
with the Cisco MDS storage products.
If checked, enables the node to detect the transmit credits from a remote node.
Auto Detect Credits are used for link flow control and for Extended Link Protocol (ELP)
Credits
login frames between Fibre Channel/fiber connectivity (FICON) Switch E
ports.
Credits
Sets the number of credits if an ELP login frame setting is missing or if the
Numeric. 2
Available
ELP login frame cannot be detected. Credits Available is editable only if
through 256,
DLP-D355 Change Distance Extension Port Settings for the FC_MR-4 Card
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Auto Detect Credits is unchecked.

multiples of 2
only

Note: Longer distances between connected devices need more credits to
compensate for the latency introduced by the long-distance link. The value
should never be greater than the number of credits supported by the Fibre
Channel/FICON port.
Autoadjust
GFP Buffer
Threshold

If checked, guarantees the best utilization of the SONET/SDH transport in
terms of bandwidth and latency.

Sets the GFP buffer depth. GFP Buffers Available is editable if Autoadjust
GFP Buffer Threshold is unchecked. For shorter SONET transport distances,
GFP Buffers
Cisco recommends lower values to decrease latency. For longer SONET
Available
transport distances, Cisco recommends higher values to provide higher
bandwidth.

Numeric. 16
through 1200,
multiples of
16 only

4. Click Apply.
5. Return to your originating procedure (NTP).

DLP-D356 Change Enhanced FC/FICON Port Settings for the FC_MR-4 Card
Purpose
This task changes the enhanced FC/FICON parameters for FC_MR-4 ports.
Tools/Equipment
None
Prerequisite Procedures DLP-D60 Log into CTC
Required/As Needed
As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: For the default values and domains of user-provisionable card settings, refer to the "Network Element
Defaults" appendix in the Cisco ONS 15454 SDH Reference Manual.
1. In node view, double-click the FC_MR-4 card where you want to change the port settings.
2. Click the Provisioning > Port > Enhanced FC/FICON tabs.
3. Modify any of the settings described in Table 20-21 by clicking in the field you want to modify. In
some fields you can choose an option from a drop-down list; in others you can type a value or select
or deselect a check box.
Table 20-21: FC_MR-4 Card Distance Extension Port Settings

Parameter
Description
Options
Port
(Display only) The card port number.
1 through 4
If checked, prevents removal of excess Fibre Channel/FICON IDLE codes from
SONET transport. IDLEs are 8b10b control words that are sent between frames
Ingress Idle when there is no data to send. Ingress idle filtering applies only to SONET circuit
bandwidth sizes that allow full line rate Fibre Channel/FICON transport. It can be
Filtering
used for interoperability with remote Fibre Channel/FICON over third-party
SONET equipment.
Sets the maximum size of a valid frame. This setting prevents oversized
Numeric.
Maximum performance monitoring accumulation for frame sizes that are above the Fibre
2148
Frame Size Channel maximum. This can occur for Fibre Channel frames with added virtual through
SAN (VSAN) tags that are generated by the Cisco MDS 9000 switches.
2172

Table 20-20: FC_MR-4 Card Distance Extension Port Settings
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4. Click Apply.
5. Return to your originating procedure (NTP).

DLP-D357 Verify Pass-Through Circuits
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

This task verifies that circuits passing through a node that will be removed enter and
exit the node on the same VC4 and/or VC3, VC11, or VC12.
None
DLP-D60 Log into CTC
As needed
Onsite or remote
Provisioning or higher

1. In the CTC Circuits window, choose a circuit that passes through the node that will be removed and
click Edit.
2. In the Edit Circuits window, check Show Detailed Map.
3. Verify that the circuits have the same east and west port VC4, VC3, VC11, and VC12 mapping. For
example, if the circuit west port mapping is s5/p1/V1 (Slot 5, Port 1, VC4 1), verify that the east port
is also VC4 1. If the circuit has different east/west VC4s and/or VC3, VC11, or VC12s, record the
name of the circuit. Figure 20-13 shows a circuit passing through a node (doc-124) on the same VC4
(VC4 2).
Figure 20-13: Verifying Pass-Through VC4s

4. Repeat Steps 1 to 3 for each circuit that appears in the Circuits tab.
5. Delete and recreate each circuit recorded in Step 3. To delete the circuit, see the NTP-D27 Delete
Circuits. To create the circuit, see Create Circuits and Low-Order Tunnels.
6. Return to your originating procedure (NTP).

DLP-D358 Change a Multiplex-Section DCC Termination
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As
Needed

This task modifies a multiplex-section data communications channel (MS-DCC). You
can also enable or disable Open Shortest Path First (OSPF) and enable or disable the
foreign node setting.
None
DLP-D60 Log into CTC
As needed

Table 20-21: FC_MR-4 Card Distance Extension Port Settings
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Onsite/Remote
Security Level

Onsite or remote
Provisioning or higher

1. Click the Provisioning > Comm Channels > MS-DCC tabs.
2. Click the MS-DCC that you want to change.
3. Click Edit.
4. In the MS-DCC Termination Editor dialog box, complete the following as necessary:
♦ Disable OSPF on MS-DCC Link-If checked, OSPF is disabled on the link. OSPF should be
disabled only when the slot and port connect to third-party equipment that does not support
OSPF.
♦ Far End is Foreign-Check this box to specify that the MS-DCC termination is a non-ONS
node.
♦ Far end IP-If you checked the Far End is Foreign check box, type the IP address of the
far-end node or leave the 0.0.0.0 default. An IP address of 0.0.0.0 means that any address can
be used by the far end.
5. Click OK.
6. Return to your origination procedure (NTP).

DLP-D359 Change a Regenerator-Section DCC Termination
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

This task modifies a regenerator-section DCC (RS-DCC). You can also
enable or disable OSPF and enable or disable the foreign node setting.
None
DLP-D60 Log into CTC
As needed
Onsite or remote
Provisioning or higher

1. Click the Provisioning > Comm Channels > RS-DCC tabs.
2. Click the RS-DCC that you want to change.
3. Click Edit.
4. In the RS-DCC Termination Editor dialog box, complete the following as necessary:
♦ Disable OSPF on RS-DCC Link-If checked, OSPF is disabled on the link. OSPF should be
disabled only when the slot and port connect to third-party equipment that does not support
OSPF.
♦ Far End is Foreign-Check this box to specify that the RS-DCC termination is a non-ONS
node.
♦ Far End IP-If you checked the Far End is Foreign check box, type the IP address of the
far-end node or leave the 0.0.0.0 default. An IP address of 0.0.0.0 means that any address can
be used by the far end.
5. Click OK.
6. Return to your origination procedure (NTP).

DLP-D360 Delete a Regenerator-Section DCC Termination
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed

This task deletes an SDH RS-DCC termination on the ONS 15454
SDH.
None
DLP-D60 Log into CTC
As needed
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Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: Deleting a DCC termination can cause you to lose visibility to nodes that do not have other DCCs or
network connections to the CTC computer.
1. In node view, click the Provisioning > Comm Channels > RS-DCC tabs.
2. Click the RS-DCC termination and click Delete. The Delete RS-DCC Termination dialog box
appears.
3. Click Yes in the confirmation dialog box.
4. Return to your originating procedure (NTP).

DLP-D361 Create a DCC Tunnel
This task creates a DCC tunnel to transport traffic from third-party SDH
equipment across ONS 15454 SDH networks. Tunnels can be created on the
Purpose
RS-DCC channel (D1-D3) (if not used by the ONS 15454 SDH as a terminated
DCC), or any MS-DCC channel (D4-D6, D7-D9, or D10-D12).
Tools/Equipment
STM-N cards must be installed.
Prerequisite Procedures NTP-D127 Verify Network Turn-Up
Required/As Needed
As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: Cisco recommends a maximum of 84 DCC tunnel connections. Terminated RS-DCCs used by the
ONS 15454 SDH cannot be used as DCC tunnel endpoints, and an RS-DCC that is used as a DCC tunnel
endpoint cannot be terminated. All DCC tunnel connections are bidirectional.
1. In network view, click the Provisioning > Overhead Circuits tabs.
2. Click Create.
3. In the Overhead Circuit Creation dialog box, complete the following in the Circuit Attributes area:
♦ Name-Type the tunnel name.
♦ Circuit Type-Choose one:
◊ DCC Tunnel-D1-D3-Allows you to choose either the RS-DCC (D1-D3) or an
MS-DCC (D4-D6, D7-D9, or D10-D12) as the source or destination endpoints.
◊ DCC Tunnel-D4-D12-Provisions the full MS-DCC as a tunnel.
4. Click Next.
5. In the Circuit Source area, complete the following:
♦ Node-Choose the source node.
♦ Slot-Choose the source slot.
♦ Port-If displayed, choose the source port.
♦ Channel-These options appear if you chose DCC Tunnel-D1-D3 as the tunnel type. Choose
one of the following:
◊ DCC1 (D1-D3)-This is the RS-DCC.
◊ DCC2 (D4-D6)-This is MS-DCC 1.
◊ DCC3 (D7-D9)-This is MS-DCC 2.
◊ DCC4 (D10-D12)-This is MS-DCC 3.
DCC options do not appear if they are used by the ONS 15454 SDH (DCC1) or other
tunnels.
6. Click Next.
7. In the Circuit Destination area, complete the following:
♦ Node-Choose the destination node.
♦ Slot-Choose the destination slot.
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♦ Port-If displayed, choose the destination port.
♦ Channel-These options appear if you chose DCC Tunnel-D1-D3 as the tunnel type. Choose
one of the following:
◊ DCC1 (D1-D3)-This is the RS-DCC.
◊ DCC2 (D4-D6)-This is MS-DCC 1.
◊ DCC3 (D7-D9)-This is MS-DCC 2.
◊ DCC4 (D10-D12)-This is MS-DCC 3.
DCC options do not appear if they are used by the ONS 15454 SDH (DCC1) or other
tunnels.
8. Click Finish.
9. Put the ports that are hosting the DCC tunnel in service. See the "DLP-D214 Change the Service
State for a Port" task for instructions.
10. Return to your originating procedure (NTP).

DLP-D362 Delete a Multiplex-Section DCC Termination
Purpose
This task deletes an SDH MS-DCC termination on the ONS 15454 SDH.
Tools/Equipment
None
Prerequisite Procedures D60 Log into CTC
Required/As Needed
As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Caution! Deleting a DCC termination can cause you to lose visibility of nodes that do not have other DCCs
or network connections to the CTC computer.
1. In node view, click the Provisioning > Comm Channel > MS-DCC tabs.
2. Click the MS-DCC termination to be deleted and click Delete. The Delete MS-DCC Termination
dialog box appears.
3. Click Yes in the confirmation dialog box. Confirm that the changes appear; if not, repeat the task.
4. Return to your originating procedure (NTP).

DLP-D363 Provision Regenerator-Section DCC Terminations
This task creates the SDH RS-DCC terminations required for alarms, administration
data, signal control information, and messages. In this task, you can also set up the node
so that it has direct IP access to a far-end non-ONS node over the DCC network. In
Purpose
addition, this task can create an OSI subnetwork point of attachment on the DCC to
allow the node to be networked with third-party network elements (NEs) that are based
on the OSI protocol stack.
Tools/Equipment None
Prerequisite
DLP-D60 Log into CTC
Procedures
Required/As
As needed
Needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Caution! If the ONS 15454 SDH is configured as an OSI IS Level 1 or IS Level 1/Level 2 node and you are
provisioning an OSI-only (LAP-D) RS-DCC to a third party NE, verify that the maximum area routing
parameter on the vender NE is set to 3 before you start this task.
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Note: When RS-DCC is provisioned, an MS-DCC termination is allowed on the same port, but is not
recommended. Use RS-DCC and MS-DCC on the same port only during a software upgrade when the
software version does not support MS-DCC. You can provision RS-DCCs and MS-DCCs on different ports
in the same node.
1. In node view, click the Provisioning > Comm Channels > RS-DCC tabs.
2. Click Create.
3. In the Create RS-DCC Terminations dialog box, click the ports where you want to create the DCC
termination. To select more than one port, press the Shift key or the Ctrl key.
Note: RS-DCC refers to the regenerator section DCC, which is used for ONS 15454 SDH
DCC terminations. The SDH multiplex-section DCCs and the regenerator-section DCC
(when not used as a DCC termination by the ONS 15454 SDH) can be provisioned as DCC
tunnels. See the "DLP-D361 Create a DCC Tunnel" task.
4. In the Port Admin State area, click the Set to `unlocked' radio button.
5. Verify that the Disable OSPF on DCC Link check box is unchecked.
6. If the RS-DCC termination is to include a non-ONS node, check the Far End is Foreign check box.
This automatically sets the far-end node IP address to 0.0.0.0, which means that any address can be
specified by the far end. To change the default to a specific the IP address, see the "DLP-D359
Change a Regenerator-Section DCC Termination" task.
7. In the Layer 3 box, perform one of the following:
♦ Check the IP box only-if the RS-DCC is between the ONS 15454 SDH and another ONS
node and only ONS nodes reside on the network. The RS-DCC will use Point-to-Point
Protocol (PPP).
♦ Check the IP and OSI boxes-if the RS-DCC is between the ONS 15454 SDH and another
ONS node and third party NEs that use the OSI protocol stack are on the same network. The
RS-DCC will use PPP.
♦ Check OSI box only-if the RS-DCC is between an ONS node and a third party NE that uses
the OSI protocol stack. The RS-DCC will use the LAP-D protocol.
Note: If OSI is checked and IP is not checked (LAP-D), no network connections will appear
in network view.
8. If you checked OSI, complete the following steps. If you checked IP only, continue with Step 9.
1. Click Next.
2. Provision the following fields:
◊ Router-Choose the OSI router.
◊ ESH-Sets the End System Hello (ESH) propagation frequency. End system NEs
transmit ESHs to inform other ESs and ISs about the NSAPs it serves. The default is
10 seconds. The range is 10 to 1000 seconds.
◊ ISH-Sets the Intermediate System Hello (ISH) protocol data unit (PDU) propagation
frequency. Intermediate system NEs send ISHs to other ESs and ISs to inform them
about the IS NETs it serves. The default is 10 seconds. The range is 10 to 1000
seconds.
◊ IIH-Sets the Intermediate System to Intermediate System Hello (IIH) PDU
propagation frequency. The IS-IS Hello PDUs establish and maintain adjacencies
between ISs. The default is 3 seconds. The range is 1 to 600 seconds.
◊ Metric-Sets the cost for sending packets on the LAN subnet. The IS-IS protocol uses
the cost to calculate the shortest routing path. The default metric cost for LAN
subnets is 20. It normally should not be changed.
3. If the OSI and IP boxes are checked, continue with Step 9. If only the OSI is checked, click
Next and provision the following fields:
◊ Mode-Choose one of the following:
• AITS-(Default) Acknowledged Information Transfer Service. Does
not exchange data until a logical connection between two LAP-D
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users is established. This service provides reliable data transfer, flow
control, and error control mechanisms.
• UITS-Unacknowledged Information Transfer Service. Transfers
frames containing user data with no acknowledgement. The service
does not guarantee that the data presented by one user will be
delivered to another user, nor does it inform the user if the delivery
attempt fails. It does not provide any flow control or error control
mechanisms.
◊ Role-Set to the opposite of the mode of the NE at the other end of the
RS-DCC.
◊ MTU-Maximum transmission unit. Sets the maximum number of octets in a
LAP-D information frame. The range is 512 to 1500 octets. The default is
512. You normally should not change it.
◊ T200-Sets the time between Set Asynchronous Balanced Mode (SABME)
frame retransmissions. The default is 0.2 seconds. The range is 0.2 to 20
seconds.
◊ T203-Provisions the maximum time between frame exchanges, that is, the
trigger for transmission of the LAP-D "keep-alive" Receive Ready (RR)
frames. The default is 10 seconds. The range is 4 to 120 seconds.
9. Click Finish.
Note: DCC Termination Failure (EOC) and LOS alarms appear until you create all network
DCC terminations and put the DCC termination STM-N ports in service.
10. Return to your originating procedure (NTP).

DLP-D364 Provision Multiplex-Section DCC Terminations
This task creates the SDH MS-DCC terminations required for alarms, administration
data, signal control information, and messages. MS-DCCs are three times larger than
RS-DCCs. In this task, you can also set up the node so that it has direct IP access to a
far-end non-ONS node over the DCC network. In addition, you can set up the node so
Purpose
that it has direct IP access to a far-end non-ONS node over the DCC network. In
addition, this task can create an OSI subnetwork point of attachment on the DCC to
allow the node to be networked with third party NEs that are based on the OSI protocol
stack.
Tools/Equipment None
Prerequisite
DLP-D60 Log into CTC
Procedures
Required/As
As needed
Needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: When MS-DCC is provisioned, an RS-DCC termination is allowed on the same port, but is not
recommended. Use RS-DCC and MS-DCC on the same port only during a software upgrade if the software
version does not support MS-DCC. You can provision RS-DCCs and MS-DCCs on different ports in the
same node.
1. In node view, click the Provisioning > Comm Channels > MS-DCC tabs.
2. Click Create.
3. In the Create MS-DCC Terminations dialog box, click the ports where you want to create the
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MS-DCC termination. To select more than one port, press the Shift key or the Ctrl key.
Note: MS-DCC refers to the multiplex-section DCC, which is used for ONS 15454 SDH
DCC terminations. The SDH multiplex-section DCCs and the regenerator-section DCC
(when not used as a DCC termination by the ONS 15454 SDH) can be provisioned as DCC
tunnels. See the "DLP-D361 Create a DCC Tunnel" task.
4. In the Port Admin State area, click the Set to IS radio button.
5. Verify that the Disable OSPF on DCC Link check box is unchecked.
6. If the RS-DCC termination is to include a non-ONS node, check the Far End is Foreign check box.
This automatically sets the far-end node IP address to 0.0.0.0, which means that any address can be
specified by the far end. To change the default to a specific the IP address, see the "DLP-D359
Change a Regenerator-Section DCC Termination" task.
7. In the Layer 3 box, perform one of the following:
♦ Check the IP box only-if the MS-DCC is between the ONS 15454 SDH and another ONS
node and only ONS nodes reside on the network. The MS-DCC will use PPP.
♦ Check the IP and OSI boxes-if the MS-DCC is between the ONS 15454 SDH and another
ONS node and third party NEs that use the OSI protocol stack are on the same network. The
MS-DCC will use PPP.
Note: OSI-only (LAP-D) is not available for MS-DCCs.
8. If you checked OSI, complete the following steps. If you checked IP only, continue with Step 9.
1. Click Next.
2. Provision the following fields:
◊ Router-Choose the OSI router.
◊ ESH-Sets the ESH propagation frequency. End system NEs transmit ESHs to inform
other ESs and ISs about the NSAPs it serves. The default is 10 seconds. The range is
10 to 1000 seconds.
◊ ISH-Sets the ISH PDU propagation frequency. Intermediate system NEs send ISHs
to other ESs and ISs to inform them about the IS NETs it serves. The default is 10
seconds. The range is 10 to 1000 seconds.
◊ IIH-Sets the IIH PDU propagation frequency. The IS-IS Hello PDUs establish and
maintain adjacencies between ISs. The default is 3 seconds. The range is 1 to 600
seconds.
◊ Metric-Sets the cost for sending packets on the LAN subnet. The IS-IS protocol uses
the cost to calculate the shortest routing path. The default metric cost for LAN
subnets is 20. It normally should not be changed.
9. Click Finish.
Note: Multiplex-Section DCC Termination Failure (MS-EOC) and LOS alarms appear until
you create all network DCC terminations and put the DCC termination STM-N ports in
service.
10. Return to your originating procedure (NTP).

DLP-D365 Change Line and Threshold Settings for E1-42 Cards
Purpose
This task changes the line and threshold settings for the E1-42 (E-1) cards.
Tools/Equipment
None
Prerequisite Procedures DLP-D60 Log into CTC
Required/As Needed
As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: For the default values and domains of user-provisionable card settings, refer to the "Network Element
Defaults" appendix in the Cisco ONS 15454 SDH Reference Manual.
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1. In node view, double-click the E1-42 card where you want to change the line or threshold settings.
2. Click the Provisioning tab.
3. Depending on the setting you need to modify, click the Line, Line Thresholds, Elect Path
Thresholds, or SDH Thresholds tab.
Note: See Manage Alarms for information about the Alarm Profiles tab.
Note: If you want to modify a threshold setting, it might be necessary to click on the
available directional, type, and interval (15 Min, 1 Day) radio buttons and then click
Refresh. This will display the desired threshold setting.
4. Modify any of the settings found under these subtabs by clicking in the field you want to modify. In
some fields you can choose an option from a drop-down list; in others you can type a value or select
or deselect a check box.
5. Click Apply.
6. Repeat Steps 3 through 5 for each subtab that has parameters you want to provision.
For definitions of the line settings, see Table 20-22. For definitions of the line threshold
settings, see Table 20-23. For definitions of the electrical path threshold settings, see Table
20-24. For definitions of the SDH threshold settings, see Table 20-25.
Table 20-22 describes the values on the Provisioning > Line tab for the E-1 cards.
Table 20-22: Line Options for E1-42 Cards

Parameter
Port

Description
(Display only) Port number.

Port Name Port name.

Options
• 1 to 42 (E1-42 card)
User-defined, up to 32 alphanumeric/special characters. Blank
by default.
See the "DLP-D314 Assign a Name to a Port" task.

SF BER

Sets the signal fail bit error rate.

SD BER

Sets the signal degrade bit error
rate.

Line Type Defines the line framing type.
Line
Coding
Admin
State

• 1E-3
• 1E-4
• 1E-5
• 1E-5
• 1E-6
• 1E-7
• 1E-8
• 1E-9
• E1_MF
• E1_CRCMF
• E1_UNFRAMED

(Display only) Defines the E-1
HDB3 - High density bipolar - 3 Zero Substitution
transmission coding type.
Sets the port service state unless
network conditions prevent the
• Unlocked-Puts the port in service. The port service
change. For more information
state changes to Unlocked-enabled.
about administrative states, refer
• Unlocked,automaticInService-Puts the port in
to the "Administrative and
automatic in-service. The port service state changes
Service States" appendix of the
to Unlocked-disabled,automaticInService.
Cisco ONS 15454 SDH
• Locked,disabled-Removes the port from service and
Reference Manual.
disables it. The port service state changes to
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Locked-enabled,disabled.
• Locked,maintenance-Removes the port from service
for maintenance. The port service state changes to
Locked-enabled,maintenance.
Note: CTC will not allow you to change a port service state
from Unlocked-enabled to Locked-enabled,disabled. You
must first change a port to the Locked-enabled,maintenance
service state before putting it in the Locked-enabled,disabled
service state.

Service
State

(Display only) Identifies the
autonomously generated state
that gives the overall condition
of the port. Service states appear
in the format: Primary
State-Primary State Qualifier,
Secondary State. For more
information about service states,
refer to the "Administrative and
Service States" appendix of the
Cisco ONS 15454 SDH
Reference Manual.

Sets the automatic in-service
AINS Soak
soak period.

• Unlocked-enabled-The port is fully operational and
performing as provisioned.
• Unlocked-disabled,automaticInService-The port is
out-of-service, but traffic is carried. Alarm reporting
is suppressed. The ONS node monitors the ports for
an error-free signal. After an error-free signal is
detected, the port stays in the
Unlocked-disabled,automaticInService state for the
duration of the soak period. After the soak period
ends, the port service state changes to
Unlocked-enabled.
• Locked-enabled,disabled-The port is out-of-service
and unable to carry traffic.
• Locked-enabled,maintenance-The port is
out-of-service for maintenance. Alarm reporting is
suppressed, but traffic is carried and loopbacks are
allowed.
• Duration of valid input signal, in hh.mm format, after
which the card becomes Unlocked-enabled
automatically
• 0 to 48 hours, 15-minute increments

Table 20-23 describes the values on the Provisioning > Line Thresholds tab for the E-1 cards.
Table 20-23: Line Thresholds Options for E1-42 Cards

Parameter

Description
(Display only) Port number

Port
CV
ES
SES
LOSS
15 Min radio
button
1 Day radio
button

• 1 to 42 (E1-42 card)
Coding violations
Errored seconds
Severely errored seconds
The number of one-second intervals containing one or more loss of signal (LOS) defects.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 15-minute intervals.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 1-day intervals.
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Table 20-24 describes the values on the Provisioning > Elect Path Thresholds tab for the E-1 cards.
Table 20-24: Electrical Path Threshold Options for E1-42 Cards

Parameter

Description
(Display only) Port number

Port
EB
BBE
ES
SES
UAS
AISS
15 Min radio
button
1 Day radio
button

• 1 to 42 (E1-42 card)
Errored blocks
Background block errors
Errored seconds
Severely errored seconds
Unavailable seconds
Alarm indication signal
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 15-minute intervals.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 1-day intervals.

Table 20-25 describes the values on the Provisioning > SDH Thresholds tab for the E-1 cards.
Table 20-25: SDH Threshold Options for E1-42 Cards

Parameter

Description
(Display only) E-1 port

Port
ES
SES
EB
UAS
BBE
VC LO
VC4
15 Min radio
button
1 Day radio
button

• 1 to 42 (E1-42 card)
Errored seconds
Severely errored seconds
Errored blocks
Unavailable seconds
Background block errors
Virtual circuit (low-order)
Virtual circuit 4
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 15-minute intervals.
Clicking this radio button and then clicking Refresh will cause the threshold values on this
tab to display for 1-day intervals.

Note: The threshold value appears after the circuit is created.
7. Return to your originating procedure (NTP).

DLP-D366 Remap the K3 Byte
Purpose

This task provisions the K3 byte. Do not remap the K3 byte unless it is
specifically required to run an ONS 15454 SDH MS-SPRing through
third-party equipment. This task is unnecessary for most users.
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STM-16, STM-64, or MRC-2.5G-12 cards must be installed on the
MS-SPRing span that you will remap.
Prerequisite Procedures
DLP-D60 Log into CTC
Required/As Needed
As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Caution! If you remap the K3 byte, remap to the same extended byte (Z2, E2, or F1) on each side of the
span.
Tools/Equipment

1. In node view, double-click the STM-16 card that connects to the third-party equipment.
2. Click the Provisioning > Line tabs.
3. Click MS-SPRing Ext Byte and choose the alternate byte: Z2, E2, or F1.
4. Click Apply.
5. (Four-fiber MS-SPRing only) Repeat Steps 2 through 4 for each protect card.
6. Repeat this task at the node and card on the other end of the MS-SPRing span.
Note: The extension byte chosen in Step 3 should match at both ends of the span.
7. Return to your originating procedure (NTP).

DLP-D367 Provision a J2 Path Trace on Circuit Source and Destination Ports
This task creates a J2 path trace on VC12 circuit source ports and destination
ports.
ONS 15454 SDH cards capable of transmitting and/or receiving path trace must
Tools/Equipment
be installed at the circuit source and destination ports. See Table 20-26 for a list
of cards.
Prerequisite Procedures DLP-D60 Log into CTC
Required/As Needed
As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: This task assumes that you are setting up path trace on a bidirectional circuit and setting up transmit
strings at the circuit source and destination.
Purpose

1. From the View menu, choose Go to Network View.
2. Click the Circuits tab.
3. For the VC12 circuit you want to monitor, verify that the source and destination ports are on a card
that can transmit and receive the path trace string. See Table 20-26 for a list of cards.
Table 20-26: ONS 15454 SDH Cards Capable of J2 Path Trace

J2 Function
Cards
Transmit and Receive E1-42
Receive Only
STM1E-12
Note: If neither port is on a transmit/receive card, you cannot complete this procedure.
4. Choose the VC12 circuit you want to trace, then double-click it (or click Edit).
5. In the Edit Circuit window, click the Show Detailed Map check box at the bottom of the window. A
detailed map of the source and destination ports appears.
6. Provision the circuit source transmit string:
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1. On the detailed circuit map, right-click the circuit source port (the square on the left or right
of the source node icon) and choose Edit J2 Path Trace (port) from the shortcut menu.
2. Click the 16 byte button.
3. In the New Transmit String field, enter the circuit source transmit string. Enter a string that
makes the source port easy to identify, such as the node IP address, node name, circuit name,
or another string. If the New Transmit String field is left blank, the J2 transmits a string of
null characters.
4. Click Apply, then click Close.
7. Provision the circuit destination transmit string:
1. On the detailed circuit map, right-click the circuit destination port and choose Edit Path
Trace from the shortcut menu.
2. In the New Transmit String field, enter the string that you want the circuit destination to
transmit. Enter a string that makes the destination port easy to identify, such as the node IP
address, node name, circuit name, or another string. If the New Transmit String field is left
blank, the J2 transmits a string of null characters.
3. Click Apply.
8. Provision the circuit destination expected string:
1. In the Circuit Path Trace window, enable the path trace expected string by choosing Auto or
Manual from the Path Trace Mode drop-down list:
• Auto-The first string received from the source port is provisioned as the
current expected string. An alarm is raised when a string that differs from
the baseline is received.
• Manual-The string entered in Current Expected String is the baseline. An
alarm is raised when a string that differs from the Current Expected String is
received.
2. If you set Path Trace Mode to Manual, enter the string that the circuit destination should
receive from the circuit source in the New Expected String field. If you set Path Trace Mode
to Auto, skip this step.
3. Click the Disable AIS and RDI on J2 TIM check box if you want to suppress the AIS and
remote defect indication (RDI) when the Low-Order Path Trace Identifier Mismatch
(LP-TIM) alarm appears. Refer to the Cisco ONS 15454 SDH Troubleshooting Guide for
descriptions of alarms and conditions.
4. Click the Disable AIS on LO SLM check box if you want to suppress the AIS when the
Low-Order Signal Label Mismatch (LO SLM) alarm appears. Refer to the Cisco ONS 15454
SDH Troubleshooting Guide for descriptions of alarms and conditions.
5. (Check box visibility depends on card selection) Click the Disable AIS on C2 Mis-Match
check box if you want to suppress the AIS when a C2 mismatch occurs.
6. Click Apply, then click Close.
Note: It is not necessary to set the format (16 or 64 bytes) for the circuit destination expected
string; the path trace process automatically determines the format.
9. Provision the circuit source expected string:
1. In the Edit Circuit window (with Show Detailed Map chosen), right-click the circuit source
port and choose Edit Path Trace from the shortcut menu.
2. In the Circuit Path Trace window, enable the path trace expected string by choosing Auto or
Manual from the Path Trace Mode drop-down list:
• Auto-Uses the first string received from port at the other end as the current
expected string. An alarm is raised when a string that differs from the
baseline is received.
• Manual-Uses the Current Expected String field as the baseline string. An
alarm is raised when a string that differs from the Current Expected String is
received.
Table 20-26: ONS 15454 SDH Cards Capable of J2 Path Trace
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3. If you set the Path Trace Mode field to Manual, enter the string that the circuit source should
receive from the circuit destination in the New Expected String field. If you set the Path
Trace Mode field to Auto, skip this step.
4. Click the Disable AIS and RDI on J2 TIM check box if you want to suppress the AIS and
RDI when the LP-TIM alarm appears. Refer to the Cisco ONS 15454 SDH Troubleshooting
Guide for descriptions of alarms and conditions.
5. Click the Disable AIS on LO SLM check box if you want to suppress the alarm indication
signal when the LO SLM alarm appears. Refer to the Cisco ONS 15454 SDH
Troubleshooting Guide for descriptions of alarms and conditions.
6. (Check box visibility depends on card selection) Click the Disable AIS on C2 Mis-Match
check box if you want to suppress the AIS when a C2 mismatch occurs.
7. Click Apply.
Note: It is not necessary to set the format (16 or 64 bytes) for the circuit source expected
string; the path trace process automatically determines the format.
10. After you set up the path trace, the received string appears in the Received field on the path trace
setup window. The following options are available:
⋅ Click Hex Mode to display path trace in hexadecimal format. The button name
changes to ASCII Mode. Click it to return the path trace to ASCII format.
⋅ Click Reset to reread values from the port.
⋅ Click Default to return to the path trace default settings. (Path Trace Mode is set to
Off and the New Transmit and New Expected Strings are null.)
Caution! Clicking Default generates alarms if the port on the other end is provisioned with a
different string.
The Expect and Receive strings are updated every few seconds whether the Path Trace Mode
field is set to Auto or Manual.
11. Click Close.
When you display the detailed circuit window, path trace is indicated by an M (manual path
trace) or an A (automatic path trace) at the circuit source and destination ports.
12. Return to your originating procedure (NTP).

DLP-D368 Manual or Force Switch the Node Timing Reference

Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As
Needed
Onsite/Remote
Security Level

This task commands the NE to switch to the timing reference you have selected, as
long as the new reference is valid. With a Manual switch, the synchronization status
message (SSM) quality of the reference must not be lower than the current timing
reference.
None
DLP-D60 Log into CTC
As needed
Onsite or remote
Maintenance or higher

1. In node view, click the Maintenance > Timing > Source tabs.
2. From the Reference drop-down list for the desired Clock, choose the desired reference.
3. From the Operation drop-down list for the desired Clock, choose one of the following options:
♦ Manual-This operation commands the node to switch to the reference you have selected if
the SSM quality of the reference is not lower than the current timing reference.
♦ Force-This operation commands the node to switch to the reference you have selected,
regardless of the SSM quality (if the reference is valid).
DLP-D368 Manual or Force Switch the Node Timing Reference
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For information about the Clear option, see the "DLP-D369 Clear a Manual or Force
Switched Node Timing Reference" task.
4. Click Apply next to the timing source.
5. Click Yes in the confirmation dialog box. If the selected timing reference is an acceptable valid
reference, the node switches to the selected timing reference.
6. If the selected timing reference is invalid, a warning dialog appears. Click OK; the node does not
revert to the normal timing reference.
7. Return to your originating procedure (NTP).

DLP-D369 Clear a Manual or Force Switched Node Timing Reference
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

This task clears a Manual or Force switch on a node timing reference and reverts the
timing reference to its provisioned reference.
None
DLP-D60 Log into CTC
As needed
Onsite or remote
Maintenance or higher

1. In node view, click the Maintenance > Timing > Source tabs.
2. Find the Clock reference that is currently set to Manual or Force in the Operation list.
3. From the Operation drop-down list choose Clear.
4. Click Apply.
5. Click Yes in the confirmation dialog box. If the normal timing reference is an acceptable valid
reference, the node switches back to the normal timing reference as defined by the system
configuration.
6. If the normal timing reference is invalid or has failed, a warning message appears. Click OK; the
timing reference does not revert.
7. Return to your originating procedure (NTP).

DLP-D370 View Circuit Information
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

This task provides information about ONS 15454 SDH circuits.
None
DLP-D60 Log into CTC
As needed
Onsite or remote
Retrieve or higher

1. Navigate to the appropriate CTC view:
♦ To view circuits for an entire network, from the View menu, choose Go to Network View.
♦ To view circuits that originate, terminate, or pass through a specific node, from the View
menu, choose Go to Other Node, then choose the node you want to search and click OK.
♦ To view circuits that originate, terminate, or pass through a specific card, in node view,
double-click the card containing the circuits you want to view.
2. Click the Circuits tab. The Circuits tab shows the following information:

DLP-D369 Clear a Manual or Force Switched Node Timing Reference
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♦ Circuit Name-Name of the circuit. The circuit name can be manually assigned or
automatically generated.
♦ Type-Circuit types are: HOP (high-order path circuit), LOP (low-order path circuit), VCT
(VC low-order tunnel), VCA (VC low-order aggregation point), OCHNC (DWDM optical
channel network connection), HOP_v (VCAT high-order circuit), and LOP_v (VCAT
low-order circuit).
♦ Size-Circuit size. High-order circuit sizes are VC4, VC4-2c, VC4-3c, VC4-4c, VC4-8c,
VC4-12c, VC4-16c, and VC4-64c. Low-order circuits are VC11, VC12, and VC3. Optical
channel network connection (OCHNC) sizes are Equipped not specific, Multi-rate, 2.5 Gbps
No FEC (forward error correction), 2.5 Gbps FEC, 10 Gbps No FEC, and 10 Gbps FEC.
High-order VCAT circuits are VC4-nv and VC4-4c-nv and low-order VCAT circuits are
VC3-nv, where n is the number of members.
♦ OCHNC Wlen-(DWDM only) Refer to the Cisco ONS 15454 DWDM Procedure Guide for
further information.
♦ Direction-The circuit direction, either two-way or one-way.
♦ OCHNC Dir-For OCHNCs, the direction of the optical channel network connection, either
East to West or West to East. Refer to the Cisco ONS 15454 DWDM Procedure Guide for
further information.
♦ Protection-The type of circuit protection. See Table 20-27 for a list of protection types.
Table 20-27: Circuit Protection Types

Protection
Type
1+1
2F
MS-SPRing
4F
MS-SPRing

Description
The circuit is protected by a 1+1 protection group.
The circuit is protected by a two-fiber MS-SPRing.
The circuit is protected by a four-fiber MS-SPRing.

The circuit is routed on a protection channel access (PCA) path on a two-fiber MS-SPRing;
PCA circuits are unprotected.
The circuit is routed on a PCA path on a four-fiber MS-SPRing; PCA circuits are
4F-PCA
unprotected.
MS-SPRing The circuit is protected by both a two-fiber and a four-fiber MS-SPRing.
N/A
A circuit with connections on the same node is not protected.
The circuit is protected by diverse SDH topologies, for example, an MS-SPRing and an
Protected
SNCP, or an SNCP and a 1+1 protection group.
The circuit is routed on a PCA path on both two-fiber and four-fiber MS-SPRings; PCA
PCA
circuits are unprotected.
SNCP
The circuit is protected by an SNCP.
SNCP-DRI
The circuit is protected by an SNCP DRI.
SPLITTER
The circuit is protected by the protect transponder (TXPP_MR_2.5G) splitter protection.
A circuit has a source and destination on different nodes and communication is down
Unknown
between the nodes. This protection type appears if not all circuit components are known.
Unprot (black) A circuit with a source and destination on different nodes is not protected.
A circuit created as a fully protected circuit is no longer protected due to a system change,
Unprot (red)
such as removal of a MS-SPRing or 1+1 protection group.
Y-Cable
The circuit is protected by a transponder or muxponder card Y-cable protection group.
2F-PCA

DLP-D370 View Circuit Information
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◊ Status-The circuit status. Table 20-28 lists the circuit statuses that might appear.
Table 20-28: Cisco ONS 15454 SDH Circuit Status

Status
CREATING
DISCOVERED
DELETING

Definition/Activity
CTC is creating a circuit.
CTC created a circuit. All components are in place and a complete path exists
from the circuit source to the circuit destination.
CTC is deleting a circuit.
A CTC-created circuit is missing a cross-connect or network span, a complete
path from source to destination(s) does not exist, or an alarm interface panel
(AIP) change occurred on one of the circuit nodes and the circuit is in need of
repair. (AIPs store the node MAC address.)
In CTC, circuits are represented using cross-connects and network spans. If a
network span is missing from a circuit, the circuit status is PARTIAL.
However, a PARTIAL status does not necessarily mean a circuit traffic failure
has occurred, because traffic might flow on a protect path.

PARTIAL

Network spans are in one of two states: up or down. On CTC circuit and
network maps, up spans are shown as green lines, and down spans are shown as
gray lines. If a failure occurs on a network span during a CTC session, the span
remains on the network map but its color changes to gray to indicate the span is
down. If you restart your CTC session while the failure is active, the new CTC
session cannot discover the span and its span line will not appear on the
network map.

Subsequently, circuits routed on a network span that goes down will appear as
DISCOVERED during the current CTC session, but they will appear as
PARTIAL to users who log in after the span failure.
A TL1-created circuit or a TL1-like CTC-created circuit is complete. A
DISCOVERED_TL1
complete path from source to destination(s) exists.
A TL1-created circuit or a TL1-like CTC-created circuit is missing a
PARTIAL_TL1
cross-connect, and a complete path from source to destination(s) does not exist.
An existing circuit in a topology upgrade is set to this state. The circuit returns
to the DISCOVERED state once the topology upgrade is complete. For more
CONVERSION_PENDING
information about topology upgrades, see the "SDH Topologies and Upgrades"
chapter in the Cisco ONS 15454 SDH Reference Manual.
Any new circuits created to represent an alternate path in a topology upgrade
are set to this status to indicate that it is a temporary circuit. These circuits can
PENDING_MERGE
be deleted if a topology upgrade fails.For more information about topology
upgrades, see the "SDH Topologies and Upgrades" chapter in the Cisco ONS
15454 SDH Reference Manual.
DROP_PENDING
A circuit is set to this status when a new circuit drop is being added.
◊ Source-The circuit source in the format: node/slot/port "port name"
virtual_container/tributary_ unit_group/tributary_unit_group/virtual_container. (The port
name appears in quotes.) Node and slot always appear; port "port
name"/virtual_container/tributary_unit_group/tributary_unit group/virtual_container might
appear, depending on the source card, circuit type, and whether a name is assigned to the
port. For the STM64-XFP and MRC-12 cards, the port appears as port pluggable module
Table 20-27: Circuit Protection Types
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(PPM)-port. If the circuit is a concatenated size (VC4-2c, VC4-4c, VC4-8c, etc.) VCs used
in the circuit are indicated by an ellipsis, for example, "VC4-7.9" (VCs 7, 8, and 9) or
VC4-10..12 (VC 10, 11, and 12).
◊ Destination-The circuit destination in same format (node/slot/port "port name"
virtual_container/tributary_unit_group/tributary_unit_group/virtual_container) as the
circuit source.
◊ # of VLANS-The number of VLANs used by an Ethernet circuit with end points on E-Series
Ethernet cards in single card or multicard mode.
◊ # of Spans-The number of internode links that compose the circuit. Right-clicking the
column shows a shortcut menu from which you can choose Span Details to show or hide
circuit span detail.
◊ State-The circuit service state, which is an aggregate of its cross-connects. The service states
are Unlocked, Locked, or Locked-partial. For more information about circuit service states,
refer to the "Administrative and Service States" appendix of the Cisco ONS 15454 SDH
Reference Manual.
• Unlocked-All cross-connects are in service and operational.
• Locked-All cross-connects are Locked-enabled,maintenance or
Locked-enabled,disabled.
• Locked-partial-At least one cross-connect is Unlocked-enabled and others are in the
Locked-enabled,maintenance and/or Locked-enabled,disabled service states.
3. Return to your originating procedure (NTP).

DLP-D371 View the MS-SPRing Squelch Table
This task allows you to view the MS-SPRing squelch table for an ONS 15454 SDH
MS-SPRing node. Squelching replaces traffic by the appropriate path AIS; it prevents
Purpose
traffic misconnections when a working channel service contends for access to a
protection channel time slot carrying extra traffic. The table shows VC4s in the
MS-SPRing squelched for every isolated node.
Tools/Equipment None
Prerequisite
DLP-D60 Log into CTC
Procedures
Required/As
As needed
Needed
Onsite/Remote
Onsite or remote
Security Level
Retrieve or higher
1. In node view, click the Provisioning > MS-SPR tabs.
2. Click Squelch Table. In the MS-SPR Squelch Table window, you can view the following
information:
♦ VC4 Number-Shows the MS-SPRing VC4 numbers.
♦ West-Source-If traffic is received by the node on its west span, the MS-SPRing node ID of
the source appears. (To view the MS-SPRing node IDs for all nodes in the ring, click Ring
Map.)
♦ West-Dest-If traffic is sent on the node's west span, the MS-SPRing node ID of the
destination appears.
♦ East-Source-If traffic is received by the node on its east span, the MS-SPRing node ID of the
source appears.
♦ East-Dest-If traffic is sent on the node's east span, the MS-SPRing node ID of the destination
appears.
Table 20-28: Cisco ONS 15454 SDH Circuit Status
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Note: MS-SPRing squelching is performed on VC4s that carry high-order circuits only.
VC4s carrying low-order or stitched Ethernet circuits do not have entries in the squelch
table.
3. Return to your originating procedure (NTP).

DLP-D372 Import a Cisco TransportPlanner Configuration File
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

This task imports a Cisco TransportPlanner configuration file into the
node to configure the node automatically.
None
A CiscoTransportPlanner network configuration file must be located on
an available local or network drive.
DLP-D60 Log into CTC
As needed
Onsite or remote
Superuser only

1. Export the Installation Parameters for your node from Cisco TransportPlanner. If the parameters file
has been exported, continue with Step 2.
1. In Cisco TransportPlanner, right-click the node icon and choose Site Installation > Assisted
Conf Setup.
2. In the dialog box, choose a location to save the Cisco TransportPlanner installation file.
2. In CTC node view, click the Provisioning > WDS-ANS > NE Update tabs.
3. Click Import.
4. In the Import Defaults From File dialog box, enter the path to the configuration file, or click Browse
and navigate to the configuration file using the Open dialog box.
5. Click OK.
6. Click Apply.
7. Return to your originating procedure (NTP).

DLP-D388 Verify MS-SPRing Extension Byte Mapping
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

This task verifies that the extension byte mapping is the same on MS-SPRing trunk
cards that will be connected after a node is removed from an MS-SPRing.
OC48 LR/STM16 LH AS cards must be installed at one or both ends of the
MS-SPRing span that will be connected.
DLP-D60 Log into CTC
As needed
Onsite or remote
Provisioning or higher

1. In network view, double-click a MS-SPRing node with OC48 LR/STM16 LH AS trunk cards that
will be reconnected after a MS-SPRing node removal.
2. Double-click one OC48 LS/STM16 LH AS MS-SPRing trunk card.
3. Click the Provisioning > Line tab.
4. Record on paper the byte that appears in the MS-SPR Ext Byte column.
5. Repeat Steps 2 through 4 for the second OC48 LS/STM16 LH AS trunk card.

DLP-D371 View the MS-SPRing Squelch Table
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6. If the node at the other end of the new span contains OC48 LS/STM16 LH AS trunk cards, repeat
Steps 1 through 5 at the node. If it does not have OC48 LS/STM16 LH AS cards, their trunk cards
are mapped to the K3 extension byte. Continue with Step 7.
7. If the trunk cards on each end of the new span are mapped to the same MS-SPRing extension byte,
continue with Step 8. If they are not the same, remap the extension byte of the trunk cards at one of
the nodes. See the "DLP-D366 Remap the K3 Byte" task.
8. Return to your originating procedure (NTP).

DLP-D393 Switch Between TDM and DWDM Network Views
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

This task switches the CTC view between time-division multiplexing (TDM)
and DWDM network views. To provision DWDM networks, refer to the Cisco
ONS 15454 DWDM Procedure Guide.
None
DLP-D60 Log into CTC
As needed
Onsite or remote
Retrieve or higher

1. From the View menu, choose Go to Network View.
2. From the Network Scope drop-down list, choose one of the following:
♦ All-Displays both TDM and DWDM nodes.
♦ TDM-Displays only ONS 15454 SDH nodes with SDH cards including the transponder
(TXP) and muxponder (MXP) cards.
♦ DWDM-Displays only ONS 15454 SDH nodes with DWDM cards, including the TXP and
MXP cards.
Note: For information about DWDM, TXP, and MXP cards, refer to the Cisco ONS 15454
DWDM Reference Manual.
3. Return to your originating procedure (NTP).

DLP-D388 Verify MS-SPRing Extension Byte Mapping
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